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Abstract 

 

 

Forecasting Locations and Magnitudes of Pavement Loading Due to 

Development Activities 

 

 

Ahmad Alrashidan, M.S.E. 

The University of Texas at Austin, 2015 

 

Supervisor:  Randy Machemehl 
 

Forecasting future at-risk pavement locations can help prevent the expensive 

costs associated with rebuilding completely destroyed pavement. Optimizing the 

locations for preemptive maintenance results in better allocation of funds by cutting 

down total cost. Pavement maintenance makes up one of the largest expenditures for 

Departments of Transportation (DOTs) in most states, and historically over half of these 

funds have been spent on just Operations and Maintenance. Pavement lifespans 

depend on the design, maintenance, environmental influences, and traffic loading. 

Anticipating activities that cause increased truck loading can help prescribe preventative 

measures to reinforce pavement structures before they fail. This thesis focuses on 
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developing an ArcGIS-based tool that forecasts at-risk pavement failure locations by 

characterizing heavy truck trips.  This study focuses on two truck travel patterns: 1) 

urban growth truck patterns and 2) oil and gas industry truck patterns. Truck trip 

generation tables were linked with forecasted routes using ArcGIS. By forecasting the 

locations of truck routes and loadings, the Early Warning System (EWS) tool will help 

officials make better estimates on where unexpected damages will occur in order to 

give officials time to take action.  This thesis includes two models: 1) Oil and Gas 

industry in Austin TxDOT district. And 2) Urban Growth in Williamson County. The 

results of the models are maps showing locations of greatest pavement damages due to 

unusual truck traffic loading. 
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CHAPTER 1: Introduction 

Periodic pavement maintenance is a crucial part of all state DOT activities. In 

2012, the US Department of Transportation spent more than 200 billion dollars on 

highways alone. (USDOT, 2014) Every year DOTs spend millions of dollars on highway 

maintenance projects, which play a huge role in the economy of the nation. The process 

of allocating maintenance efforts to specific projects is a well-planned process based 

upon periodic data collected to describe pavement conditions. Due to the immense 

quantity of paved roads (about 200,000 lane miles for TxDOT) condition data can only 

be updated rather infrequently (annually at best). Unusually heavy traffic loading caused 

by land development or re-development or mining can distort the expected pavement 

deterioration patterns sometimes causing unexpected pavement destruction. Costs to 

totally rebuild a destroyed pavement can easily be ten times the cost of strengthening 

the pavement adequately to handle the unexpected heavy loading. In order to save 

money and cut down on maintenance costs, pavements that experience unusually 

severe traffic loading should be identified. This work describes a tool that helps 

engineers know where unusually heavy traffic loading will occur so they can invest more 

maintenance funding to strengthen those pavements or at least be aware of the need to 

perform more than normal maintenance on those pavements.  

The rate of pavement deterioration is dependent upon weather conditions, type 

of pavement and particularly traffic loading. Land development activities, sometimes 

called land use change activities including mining (petroleum resource recovery) often 
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cause large concentrations of truck traffic loading frequently on minor roads that have 

weak pavement structures.  The result is very accelerated pavement deterioration 

resulting in pavement destruction before maintenance authorities even realize what is 

happening.  Savings of up to 90 percent of the cost of total pavement reconstruction can 

be achieved if sufficient strengthening to the existing pavement is made before it is 

destroyed.  If the accelerated traffic loading occurs so rapidly that strengthening cannot 

be accomplished before major damage occurs, as is sometimes the case with mining, 

maintenance authorities could be aware of the need and could plan accordingly.    

Closely studying the users of the roads and their patterns will generate a better 

understanding of where to focus maintenance attention. In comparison to cars, fully 

loaded truck-tractor configurations (18 wheelers) typically apply up to 3 equivalent 

single axles loads (ESALs) whereas a passenger car may apply less than 0.003 (EASLS). By 

their nature, trucks accelerate pavement deterioration and use pavement life up to a 

thousand times faster than cars.  In 2002, nearly 16 billion tons (nearly 800 million fully 

loaded truck trips) of raw materials and finished goods were transported on the US 

freight system (USDOT, 2004). According to FHWA, from 1980 to 2008 lane-miles in US 

public roads increased only 8 percent to a total of approximately 8,518,000 lane-miles. 

On the other hand, Vehicle Miles Traveled (VMT) increased 51% during that same time 

(FHWA, 2008). The large increase in VMT on a network that has not been expanded or 

received appropriate preventive pavement reinforcement poses severe threats to the 

overall road network. Predicting the travel patterns of trucks can potentially reduce a 

large portion of maintenance costs.  
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Truck patterns related to the oil and gas industry and truck patterns related to 

urban growth are two examples of potentially unusual pavement wear patterns that can 

be predicted. Urban growth related trucks travel to and from retail-commercial land 

uses. Studying and following the path of this urban growth will give a better estimate on 

how to predict truck traffic flow. By knowing locations of establishments, the type of 

activity, and the area, it is possible to predict the trucks routes around the network. Oil 

and gas industry growth generates more oil/gas wells, therefore generating more truck 

activity. Studying the truck traffic related to managing wells will help to predict numbers 

of truck trips and their paths. Any rapid changes in oil and gas industry and urban 

growth will generate more truck flow, thus more severe pavement damage than 

anticipated over a short period of time.  

High truck flow rates will typically generate heavy pavement loadings. Heavy 

loadings are generally less damaging to major highways (Interstate, US or State 

numbered routes) because they are designed to carry high truck traffic across states. 

The issue occurs when heavy loadings occur on rural/local streets or county highways 

like Farm to Market or Ranch to Market highways in Texas. Local streets are usually 

designed mainly to carry passenger cars and occasionally truck traffic. County highways 

were designed originally for farmers to transport agricultural products to markets in 

towns and cities so unexpected heavy truck traffic with heavy loadings poses severe 

effects, if it not completely destroying the pavement in some cases.  

Current state of practice for maintenance differs from one state to another. 

Texas Department of Transportation (TxDOT) divides the present state of practice for 
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maintenance into three categories, preventative maintenance, routine maintenance, 

and major maintenance. TxDOT defines preventative maintenance as any maintenance 

performed to “prevent major deterioration of the pavement” examples of that would 

include overlays or seal coats. On the other hand, major maintenance can be done to 

restore destroyed pavement including replacing the base as well as the wearing surface. 

However, preventative maintenance delays the need for major maintenance since its 

main purpose is to reduce major maintenance needs. The current planning process in 

each TxDOT district consists of each individual district developing an annual plan for 

maintenance projects by “analyzing historical quantities of work performed and the 

resulting level of service” (Holland, 2014). Using historical data can be inaccurate 

especially if land use changes are not captured in the previous year’s report and new 

projects (i.e. wells or residential developments) are being built in the existing year. Level 

of service takes into account the projected traffic but that also depends on variables like 

population and historical data as well. An Early Warning System can help capture those 

changes in land use and forecast their effects on pavement. This tool will be to help 

districts to be able to prioritize pavement maintenance for more effective use of tax 

dollars.   

This thesis aims to generate a cost-effective tool that will help prevent losses by 

warning authorities about the critical road segments that are going to experience higher 

than usual truck traffic and loadings, which ultimately require preventive pavement 

reinforcement. This thesis will look into traffic loadings and routes, congestion and 

other negative impacts of truck traffic will not be included.  In the next chapters, a 
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literature review will provide an in depth review of previous studies that covered parts 

of the areas of this thesis. In the 3rd chapter, the methodology will discuss model and 

their truck trip generation tables with GIS data sources. Chapter 4 will have the results 

of the GIS model and analysis of the outputs.  
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CHAPTER 2: Literature Review 

The current practice of maintaining pavement depends on annual reports of 

pavement condition and historical data that does not take into account unexpected 

traffic changes. Unexpected high truck traffic flow will not only damage pavements, but 

will produce significant economic impacts. American Transportation Research Institute 

(ATRI) analyzed GPS data gathered from various trucks moving along the US highways to 

estimate delay hours, idle truckers, and increased cost. ATRI reported that congestion 

“added over $9.2 billion in operational costs to the trucking industry in 2013” with the 

state of Texas being the 2nd highest state suffering from operational costs related to 

congestion with over a billion dollars (ATRI, 2014). Saving money is the second most 

important thing in pavement projects after safety. Cost effective binders and asphalt 

designs help engineers save money on materials. Optimizing schedules of importance 

for projects is another way to save money and time. Studies and research on pavement 

maintenance cost reduction have focused extensively on ways to spend less and get 

better products. Predicting truck travel patterns can serve as a potential solution to 

saving money on maintenance costs. 

Preventive maintenance is usually a cost-effective procedure that is done to 

extend the pavement’s life. According to Galehouse (2003) “preventive maintenance 

can extend pavement life an average of 5 to 10 years.” However, preventive 

maintenance should be applied on the pavement at a specific time frame before failure 

in order to maximize effectiveness. The current state of practice for maintenance 

planning does not include provision for sudden, unexpected changes in typical traffic 
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patterns. This is due to the deficiency of truck data which plays a major role in damaging 

pavements. The specific truck trip characteristics are usually related to the type of 

industry because the nature of a truck is to transport goods/products from or to 

destinations. Studying industries related to the growth of truck traffic in a certain area 

can help provide truck movement data. This type of data can be a solution to the lack of 

truck data needed to form recommendations for preventative maintenance.  

 

2.1 Early studies: Characterizing pavement failure 

The early studies quantifying the effect of traffic on pavement were conducted 

by The American Association of State Highway Officials (AASHO). AASHO study saw the 

need to develop standards to help build better roads. The lack of data for pavement 

design and the need to save money by optimizing design methods was the motivation 

behind this study. The AASHO pavement design method quantified pavement failure for 

the first time and introduced the equivalent axle concept. The equivalent axle concept 

provides an expression of the pavement damage caused by one pass of any axle weight 

compared to the damage caused by one pass of a chosen standard weight axle.  An 

18,000-pound single axle is often chosen as the standard. (Kawa et al 1998). With the 

findings from AASHO, this thesis can use equivalent single axles (ESALs) to describe truck 

impacts on pavement and by that also classify the levels of importance for future 

pavement maintenance projects. 
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2.2 Previous studies: Methods for Forecasting of Pavement Failure 
Most previous research has used surveys to gather data about truck movements 

to build statistics-based forecasts. This pavement failure forecasting technique is ideal if 

data is abundant and easy to gather. However, if observations are scarce issues arise 

with these types of models. Spatially transferred data from like locations can be used, 

but it will not be accurate enough for pavement failure forecasting due to high numbers 

of variables that might affect the pavement failure. In the past, surveys have been used 

to acquire these types of data. However, surveys can be costly and time consuming, and 

updating survey data can be complicated if other factors were not accounted for in the 

first place.  

Truck trip modeling can help predict the trips made by trucks and ultimately 

their impacts on the pavement. Transportation Research Board Special Report 288 (TRB 

SR288, 2007) discussed the need for improving travel-forecasting models because of the 

lack of treatment of commercial and freight data. The lack of available data on truck 

vehicle travel in general hampers the potential development of better models. For that 

reason, researchers have designed different methods to generate reliable data or 

incorporated existing data to predict future truck movements.  

Truck traffic production and attraction GIS data can be used to as an alternative 

to actual truck data to develop truck flow prediction models. Tirado et al (2006) used a 

finite element model to calculate the pavement distress and then developed a graphical 

output using Visual Basic to be used on ArcView (GIS Software) to show the damages 

caused by super heavy loads on a specific route. Tirado introduced the use of GIS 



 
9 

 

software to develop models that can help visualize locations of distress and rutting. 

However, ArcGIS has the power to be used not only as a visual tool to show outputs of 

other software, but also as an analysis tool.  Another study that used GIS based data for 

pavement research, Osegueda et al. (1997), used overweight/oversize permit data in 

relationship with available GIS base maps from the TxDOT database to generate shortest 

paths between origins and destinations in Houston. The tool is easy to update with new 

data, TransCAD GIS software shows the maps, and the Dijkstra algorithm finds the 

shortest path between origins and destination. Osegueda et al. (1997) considered the 

issued overweight/oversize permits and investigated the condition of bridges (using the 

BRINSAP database) along the route of the permit. However, this study only considered 

the damage on specific bridge locations and did not consider predicting where the most 

damage will occur along routes. This thesis will use truck trip generation tables and GIS 

data to characterize pavement damage in terms of ESAL loadings along routes. This 

alternative approach can save money and time in comparison to traditional surveying 

techniques. Moreover, ESAL data is easily accessible and updated frequently, therefore 

a model can be built for recurrent use. Previous studies about truck trips related to 

urban growth and land use changes will be discussed first followed by truck trips related 

to the Oil and Gas Industry.   

 

2.3 Previous Studies: Characterizing Urban Area Related Truck Trips 

Urban growth leads to land use changes that are facilitated by truck traffic. 

These changes are desirably captured in transportation plans that are intended to 
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improve accessibility or mobility. Some statewide plans identify major truck corridors 

and provide instructions on how to predict and prepare for truck impacts. In the case of 

smaller developments, the concerns for developers are usually accessibility and/or 

mobility of the site. Research concerning land use changes and urban growth has shown 

little effort in how to predict the effects of the additional truck movements that are 

associated with urban growth.  

Traditionally, the four-step demand estimation model has been used to create 

transportation infrastructure plans. Trip generation is the first step in the traditional 

four-step transportation-planning model. This includes tables consisting of trip ends 

produced and attracted by each development or zone. Trip distribution, the next step in 

the model, uses trip ends as origins and destinations connecting trip ends to make trips. 

The trip distribution step generates an origin-destination (O-D) matrix characterizing the 

trips between zones. The third step is mode choice, which can be skipped when 

modeling truck trips because there is only one mode option. The final step in the four-

step model is traffic assignment or route choice, which in most cases will be the shortest 

distance path. This step is crucial to maintenance and loss prevention planning because 

it determines which routes the trucks are going to take and which routes will most likely 

suffer most damage.  

Most planning methods for smaller urban areas and rural areas have assumed 

that trucks are only a small fraction of the traffic, however studies show that trucks 

make up a significant portion and should not be ignored. Cambridge Systematics (2004) 

used the Freight Analysis Framework data to analyze congestion in urban and rural 
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areas, with and without truck data, and found that excluding truck data would only 

show congestion in urban areas and not any of the congestion present in rural areas. 

This shows that trucks have a direct impact on congestion in rural areas. Another study 

conducted by Cambridge Systematics (2005) used weigh-in-motion (WIM) data from 55 

sites in California and reported that on a single weekday the percent of trucks composes 

4% to 14% of the traffic flow. Moreover, the most congested time of day is from 8am to 

5pm at which time the average truck flow reaches nearly 10%. Given the fact that trucks 

are on average three times larger than a passenger car, 10% of the flow might take up to 

a 30% of the capacity of the streets. Additionally, Motuba (2009) showed that trucks are 

a significant fraction of the traffic in small to medium sized urban areas and can cause 

congestion, therefore requiring careful attention during planning stages. These studies 

have highlighted the importance of considering truck traffic in small to medium sized 

urban areas as well as rural areas. Planners should consider truck traffic as a significant 

portion of the traffic in all areas. This thesis considers truck trip traffic as the primary 

indicator for future damage because trucks accelerate pavement deterioration, and 

because they make up a significant portion of the traffic as well.  

Many studies have created Truck Trip Generation Tables (TTGTs) for various 

cities that provide the rate for truck flow in and out of a development by various 

variables, such as trip purpose or size of establishment. The Institute of Transportation 

Engineering (ITE) Trip Generation Manual is widely used to forecast traffic flow 

numbers. However, ITE reported trip rates pay little attention to truck traffic flow. This 

is why most research studies resort to generating tables based on data and regression 



 
12 

 

statistics. Tadi and Balbach (1994) developed TTGTs based on regression statistics for 

nonresidential land uses in the city of Fontana. In their study, they gathered data from 

21 sites by both manual and machine counts and generated tables based on weekday, 

morning peak hour, afternoon peak hour, and site peak hour. The variables in this study 

were square feet of building area of warehouse, industrial, and industrial park 

developments.  Jaller et al (2014) used area size of developments in New York City to 

create Freight Trip Generation (FTG) tables from regression statistics. The findings 

showed that type of employment and area-size had a strong relationship in 

determination of freight trips. The study mainly aimed to generate FTG tables that use 

land area as the variable to forecast trips, however the model lacks flexibility because it 

only works with datasets that include area size.  Another study that took into account 

categories not in the ITE Manual was Neustaedter et al (2003), which developed City of 

Fontana TTGTs based on regression analysis of three independent variables. The study 

surveyed 34 locations and divided land use classifications into eight categories. Three 

out of the eight categories: truck sales, used truck lots, and truck stops, are not included 

in the ITE Manual. Number of employees, gross building area, and acres were the three 

independent variables in the study. In some developments, the operational truck traffic 

flow is not necessarily independent of the area size, as shown by McCormack et al 

(2010). Their study focuses on 8 grocery stores in the Seattle area and their relationship 

to truck traffic flow. The report developed TTGTs based on data collected through 

phone interviews and manual traffic counts. The study did not find that grocery store 

variation in size led to more or less truck traffic.  However, a reason for that could be 
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that the sizes of the grocery stores chosen in this study were very close to each other. 

This study will apply truck trip data acquired from previous studies on different types of 

development. 

 

2.4 Previous Studies: Characterizing Oil and Gas Industry Related Truck Trips: 

The oil and gas industry plays a vital role in the economy of Texas and the 

associated effects of truck traffic impact the road network tremendously. In 2014, there 

were more than 1 million active wells in the United States and more than ¼ of those 

wells are located in Texas (Kelso, 2014). This puts a huge burden on the transportation 

network in Texas as it provides oil for most of the surrounding states and its own fast 

growing population.  

The effect of unexpected loading has been extensively studied in the area of 

bridge and road structures, but recently this concept has received more attention for 

pavement management. The majority of the studies on pavement management are 

focused on how to deal with overloading by improving asphalt material. The Utah 

Department of Transportation (UDOT) developed a manual for pavement management 

to provide a cost effective solution for pavement rehabilitation design. Their approach is 

evaluating pavement prior to rehabilitation.  An enormous strategy between scheduling, 

organizing and designing pavements has been studied and a cost effective solution for 

each pavement condition was proposed. This report focuses on solution not causation. 

Another recent study conducted by Sianipar (2014) examined the influence of traffic 

growth and overload on road life-cycle.  They found that the biggest cause of life-
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performance decrease is overload, and that the effects are non-linear. This shows that 

overloading the pavements can cause severe damages and cannot be predicted linearly. 

The rate of damages can be faster than the rate of overloading.  

Several studies evaluated the expected damage and cost caused by oil & gas 

development activities. TxDOT has started to evaluate short-term and long-term 

impacts of energy related activities on the state’s transportation infrastructure. 

Moreover, Quiroga et al (2012) provided a comprehensive document on the impacts, 

needs, and strategies for TxDOT, including the effects of horizontal well activity. They 

estimated a typical rural road would lose 39% of its life after one year of 100 horizontal 

gas wells. Considering re-fracking the wells every five years, they estimated the 

pavement would reach the end of its life before ten years. Abramzon (2014) provided a 

similar technical report for the Pennsylvania Department of Transportation (PennDOT). 

The report revealed the per-well cost depends linearly on the number of truck trips and 

the length of the truck trip. If the average one-way trip deceases by half, the per-well 

fee could be reduced by 50%. They recommend a comprehensive design policy that 

motivates companies to minimize activities that damage the roads. Reimer (2014) 

developed a framework for the oil & gas industry to optimize their transportation 

activities. This study develops an integrated framework for the state’s Department of 

Transportation to prioritize road segments for maintenance. However, none of these 

studies have recommended a way to determine exact location for these types of 

damages. 
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Different studies addressed the problem of hydraulic fracturing (fracking) in 

relation to various variables, however Prozzi (2011) addressed the fracking problem and 

its impact on transportation infrastructure by using GIS-based data to find the shortest 

route that trucks would take. Prozzi discussed that there is an increasing demand on the 

Texas infrastructure, especially the rural roads that are used for moving equipment into 

sites, since 30% of the US natural gas and 19% of the US oil is produced in Texas. In her 

study, she located active gas wells and assumed the closest disposal well was the one in 

service. The routes between the truck’s origins and destinations were generated 

through Google Maps. Vehicles Miles of Travel (VMT) was the variable used to 

emphasize the percentage of truck trips that traveled on rural roads. In her findings, 

30% of truck trips moving water to disposal wells were using local streets.  

In the next chapters, the methodology in this thesis is developed based on 

current research gaps. One of those gaps is linking the GIS source with Truck Trip 

Generation to forecast locations of heavy loadings. Traditionally, statistical estimations 

predict truck traffic impacts. However, this thesis will use shortest path routes to 

forecast truck impacts. Two case studies will be built based on the methodology and 

their analysis and results will be discussed after.  
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CHAPTER 3: Methodology 

The methodology of this thesis will be built on 3 steps, generating Truck Trip 

Generation Tables based on analyzing previous studies. Gathering GIS locations of trips 

associated with land use changes, which will generate unexpected truck trips added to 

the network. The last step is to link TTGTs to GIS data based on ArcGIS to forecast these 

trips shortest routes with their loadings. The output of the model is a map that shows 

locations of total loading values on each segments of the network.  

3.1 Urban Growth and Land Use Changes: 

 Urban growth usually generates rapid land use changes. These changes affect 

transportation networks as they cause more traffic to use existing infrastructure. 

Capturing those land use changes when planning helps in planning better arrangements 

for pavement service life. Building a brick plant in a rural area can and will generate 

heavy truck traffic that generally has high loadings as well. These loadings can cause the 

pavement to fail before the end of its expected service life. DOT districts end up paying 

millions of dollars to reconstruct failed pavements while it would be more cost effective 

if sufficient reinforcements were made on the pavement. These land use changes can be 

tracked and their effects on the pavement can be predicted. If the district knows where 

the brick plant is going to be built, the size of the plant, the origins and destinations for 

the associated truck traffic, it could easily predict future damages on the routes. The 

method described in this thesis uses GIS locations of future land use, type of 

establishments, and establishment area sizes.  
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 The first step in the traditional four-step transportation planning model is trip 

generation. Depending on the data source, an estimate of how many trucks are going in 

and out of each establishment can be generated. Based on previous studies, NCHRP 298 

reported that the general practice to predict trucks generated by a certain land use is to 

use independent variables like square feet of land used or employment numbers to 

generate establishment based truck trips. Moreover, Jaller et al (2014) studied 1890 

models of trip rates and regression models for production and attraction and found 

41.59% of these models used area, 29.89% used employment, and 14.71% used 

establishment type. While establishment type can serve as a predictor, using it could 

lead to errors because it over generalizes the number of trips. For example, an 

establishment-based trip model will give the same number of trucks for a grocery store 

regardless of the size. These results could be misleading because grocery stores can vary 

highly in size, which ultimately leads to variation in truck trip rates as well.   

 Reliable truck trip forecasting uses an equation not only limited to area, 

employment, or establishment type but also includes number of days that the 

establishment experiences truck traffic.  
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Figure 1: ESAL ratios during a week. Source: Cambridge Systematics 2005. 

 

Figure 1 shows higher daily ESAL ratios from Monday to Friday, which implies 

that days of the week will generate different truck traffic rates. Tadi and Balbach (1994) 

built their truck trip rates on the fact that weekdays truck traffic rates are different than 

weekend rates. They studied truck traffic rates on a weekday and weekend basis, and 

included peak hour rates for AM and PM of weekdays.  
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Figure 2: Truck percent of traffic through 24 hours of the day. Source: Cambridge Systematics 2005. 

 

Time of day plays another major role in determining traffic trips rates. Figure 2 

shows most of the truck traffic travels during business hours. This fact may add another 

variable to the list of variables affecting truck trip generation tables. The last factor we 

consider in this thesis is truck configuration. The word truck has a large definition that 

might include any type of vehicle that is used to transfer products and goods. A better 

understanding of the degree of damage can be achieved by answering the question: 

what type of truck can be most damaging? According to FHWA (2000) more than 42% of 

the trucks in the nation are 3-S2 trucks. This makes it the most common truck types in 

the United States. The 3-S2 truck configuration is shown in Figure 3. An SU2 truck is the 

second most common type making up more than 35% of the trucks on the road. An SU2 

truck is a single unit with 2 axles. The rest of the configuration types are divided among 
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more than nine different types and can be considered negligible due to their rare 

existence. The variables used for establishment-based Truck Trip Generation Tables are 

the following:  

 Size of Establishment (acres, square footage); 

 Employment (number of employees in each establishment); 

 Type of Establishment (rates can be generated on type of establishment only); 

 Days of activity (days that the establishment will be receiving/sending trucks); 

 Hours of activity (hours of day that that the establishment will be 

receiving/sending trucks); and 

 Truck Configuration (type of trucks).  

Figure 3: 3-S2 Truck Configuration and ESAL loading. 

  

ESALs can provide a better estimate for the damage a single pass of a truck on 

specific pavement can cause. As discussed earlier, ESALs describe the damage a specific 

axle load causes to the pavement, compared to a single axle load of 18Kip. According to 

FHWA standards for commercial vehicle weight, the maximum gross vehicle weight is 

80Kips (FHWA, 2013). Figure 3 shows a likely breakdown of 80Kip and 130Kip gross 
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weights on the axles. Assuming rigid pavement and structural number of two based on 

AASHTO design methods, Table 1 show ESAL value example calculations based on the 

truck weight.  

Table 1: ESAL Number Calculation for Different Weights. 

 

 In general, models are with specific variables in mind and exclude some 

negligible variables. In this thesis, we are mainly concerned with trucks that may cause 

significant pavement damage. In this model, these truck can travel at any time of the 

day causing congestion and pavement related issues. Previous research tried to 

minimize congestion caused by these trips by suggesting scheduled deliveries at times 

outside of the peak hour traffic. However, this type of schedule will not be included in 

this thesis and travel time of the day will not be a concern.  

 

3.1.1 Urban Model Truck Trip Generation Tables:  

Truck traffic related to urban land developments can be mainly categorized into 

two phases, construction and production traffic. Construction traffic refers to the truck 

traffic transporting construction materials and equipment in and out of the site. Because 

the small size of this traffic in relation to production, very few studies considered 

studying this activity to make travel predictions. Construction traffic varies highly from 

project to project, not only because of the size of the establishment or the amount of 

Purpose Full Weights ESAL (Value)
Max. Legal limit 80,000 12 0.229 34 2.22 2.449

Heavy Trucks 130,000 18 1.49 56 8.1 9.59

ESAL Number Configuration
2 Tandem Axles (Kips)Single Axle (Kips)
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materials, but also because of the funding available for the project. A time-sensitive 

project could have more funding invested to finish the project in less time. An effect of 

doing more work in less time generally generates more truck traffic. However, in this 

thesis these variables are not considered. Truck traffic for construction purposes can be 

sufficiently treated by dividing it into two sub-categories: residential developments and 

all other developments. According to the US 2010 Census, an average lot size for a new 

single-family house sold in the United States is 17,590 square feet. To maintain 

conservative predictions, this study uses 15,000 square feet in determining house lot 

area sizes. However, different areas might have different lot sizes, this can be done on a 

case by case basis. 

Construction TTGTs will be built based on three assumptions:  

1) An average house requires two 3-S2 trucks to get the concrete/timber and 

equipment needed (If an average lot is 15,000 square feet, then every 7,500 

square feet of lot requires one truck) 

2) One truck will be required per 1000 square feet of building gross floor area for 

any other development (i.e., industrial, manufacturing, and warehouses) since 

most of these establishments will have concrete slab and steel hanger systems, 

3) Construction traffic will be studied in a one-year period, meaning that at least 

every year the construction traffic model should be updated.  

 

In this thesis, the theory of “it is safe to overestimate rather than 

underestimate” was followed in these assumptions and other assumptions that will be 
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discussed later. Table 2 shows the truck trip generation for construction traffic that was 

built on previous assumptions.  

Various studies projected future production truck traffic for land-use changes. 

Production is easier to predict based on consistency of travel patterns or repetitions of 

some deliveries to or from the site. Also, Production traffic continues to be observed at 

least for the first 20 years or when the establishment changes the business type, which 

affects the flow of trucks greatly. Production TTGTs rates were gathered from three 

studies that use the same variable to predict the trips: trucks rates per 1000 square feet 

of establishment area size. Tadi and Balbach (1994) predicted the land use of “Heavy 

Industrial” trips to have 4, 5, and 6+ axle trucks traffic of 0.38 per 1000 square feet. In 

Boston, Nixon (1993) studied all 6+ axel truck traffic by land-use type and generated the 

tables based on trips per 1000 square feet. His rates for manufacturing sites, 

warehouses, and residential production activity were respectively 0.35, 0.44, and 0.11. 

McCormack et al (2010) results yielded 18 truck trips per day on a weekday, which this 

study assumed to be the peak as well. Taking the value of 18 trucks per day and dividing 

it by the average grocery store size in the Seattle area will give a rate of 0.51 trips per 

day per 1000 square feet. Table 3 shows the truck trip generation for production traffic.  

Table 2: Construction Truck Trip Generation. 

 

 

Purpose ESAL (Value) ESALs/Trip

All Purposes 2.449 2.449
Residential 2.449 2.449

Construction Activity Rates
One truck per

1,000 SF
7,500 SF
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Table 3: Production Truck Trip Generation.  

 

3.1.2 GIS Mapping Tool: 

 The TTGTs determine the truck trips associated with each land development, but 

they do not tell us any route information. The goal here is to predict the routes that 

trucks will follow with GIS and connect their impacts on the pavement determined by 

the TTGTs to these routes. This step depends strongly on the GIS data source, 

specifically the locations of the developments and the variables associated with it. For 

this thesis, the main variable chosen was volume in terms of 1000 SF area size. 

Connecting the locations of developments to their origins or destinations can be 

complex. There are a lot of different locations that are associated with sending or 

receiving trucks to a certain development. For example, a commercial warehouse will 

have truck traffic from/to the regional distribution center and different customer 

locations, which are difficult to predict. Other possible origins/destinations for other 

facilities could be much more challenging to predict.  

ArcGIS will be the GIS mapping tool used in this study to read GIS data, predict 

routes, and calculate damages based on ESAL values. In this case, shapefiles, a file 

format used by ArcGIS, are the ideal file format as it is the file format that ArcGIS 

employs to manage the base map and associated attribute information. However, excel 

Purpose Source

Industrial 0.38 /1000 SF Tadi 1994

Grocery store 0.51 /1000 SF  McCormack 2010

Manufacturing 0.35 /1000 SF Boston 1992

Warehouse 0.44 /1000 SF Boston 1992

Residential 0.011 /1000 SF Boston 1992

Volume

Production Activity Rates
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files with longitudes and latitudes can be exported and used in ArcGIS and will work as 

well. The ArcGIS Network Analyst extension calculates the shortest distance between an 

origin and destination using the Djikstra algorithm. This tool can also find the shortest 

path in terms of time of travel; in this thesis the focus will only be on the shortest path 

travelled in terms of distance. Network Analyst has a variety of different tools that cater 

to a myriad of complex routing problems that a user might be looking to solve. One of 

these tools is Closest Facility, which solves the shortest path between an origin and 

destination. However, the tool uses two names for these origin/destination locations: 

Facility and Incident. In this tool, every incident needs to be connected to a facility, but 

not every facility must be connected to an incident. An example of that would be 

locations of grocery store incidents and distribution centers as the facilities. For each 

grocery incident a route connecting the distribution center with it will be generated. 

However, some distribution centers will not be used in the analysis as they might not be 

needed. The reason behind using this particular tool is that the scope of this thesis is 

focused on land use changes that are going to be served by different locations. The land-

use change locations (oil and gas wells, a new residential development) will be the 

“incident” and the cause of truck traffic to travel from the facilities to serve the needs of 

the “incidents”, however not every facility will be connected to an “incident” in this 

case. Trucks traveling to service the needs of these land-use changes will generate loads 

that are not expected, and must be predicted.  

GIS-based locations are linked with the current road network, and depending on 

the development type, will generally generate two types of traffic: construction and 
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operation. The model will have a map for each type of traffic. Forecasting the truck 

routes should be done based on an origin/destination methodology, however at this 

point, only one end of the route is known – the land development location. The other 

end of the route is hard to predict, because trucks can travel in many different 

directions without the ability of the model to predict these routes. However, trucks 

usually travel on highways for longer trips, and generally heavy trucks tend to travel 

longer distances to transport mass products. Connecting the land development location 

to the nearest state highway is a good representation of what happens. Additionally, it 

is an ideal choice for travel because state highways are usually designed and maintained 

to handle high truck traffic. Additionally, choosing a state highway route captures the 

local streets that are used as access routes for trucks related to land development. 

These streets are the most likely to be destroyed because local streets are built and 

maintained with the assumption that they will experience very low truck volumes in 

most cases, which leads to undesirable consequences in the case of an unexpected 

increase in truck volumes. The state highways that are going to be considered as origins 

and destinations are: Interstate highways, State Highways, and US highways (IH, SH, and 

US). Another suggestion for GIS analysis of other models, the prediction can be done 

based on a buffer zone around the developments with a radius of a specific distance. 

Based on population or employment working as traffic magnets, the assignment of truck 

routes will be on the corridors with cardinal directions traveling in the heavy population 

or employment direction. Depending on the truck activity data it could also be seen as 
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the data of origins or destinations of potential truck movements that could be used to 

produce truck routes 

 

3.2 Oil and Gas Industry Growth: 

In Texas, oil and gas well locations are typically in West Texas or in the Gulf of 

Mexico, approximately 200 miles away from shore. Figure 4 shows that the locations of 

active oil and gas wells. Note that most of them are not close to a major highway.  

Figure 4: Active Oil and Gas Wells in Texas. Source: TCEQ 2014. 

 

Constructing and operating these wells requires transportation of equipment, 

water, and other products. The recent boom in oil and gas unconventional shale plays 
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requires that these products be transported by a large number of very heavy trucks, 

which were probably not expected during pavement design. Widespread use of 

hydraulic fracturing, or fracking, has generated more heavy trucks in comparison to 

traditional drilling activities. This is specifically due to the extremely high need for water 

related to each well construction and production activity. According to the US 

Department of Energy (2013), up to 95 percent of new wells being drilled are 

hydraulically fractured. In the United States, these wells make up 43 percent oil and 57 

percent natural gas production on average. The highly repetitive trips and loadings 

associated with servicing the wells are usually concentrated on low volume roads that 

have thin pavement structures. Such loadings can severely damage, or even destroy the 

pavement. These trips are providing equipment, supplying water, disposing of water, 

and carrying aggregates and chemicals to the site of each oil well.  

 

3.2.1 Oil and Gas Model Truck Trip Generation Tables: 

The main element transported to and from fracked wells during construction and 

production is water. The water volumes moved per well were determined from 

information obtained from fracfocus.org, a voluntary disclosure database that gives 

details of hydraulic fracturing in the United States. This site provides information about 

water volume, date of well drilling, and the percentage by weight of fracking fluids 

which varies when involving water, sand, and standard chemicals.  For this study, a 

sample of data from three counties in Texas, Caldwell, Bastrop, and Lee, was selected 
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and extracted.  Locations and approval dates of oil drilling permits and active saltwater 

disposal well information was gathered from the Railroad Commission of Texas (RRC).  

The sample data extracted from RRC included information on 21 oil wells. Thus, 

the dates for which the permit was submitted and approved could be found. The start 

date for drilling was also noted for this study. The average expected time upon approval 

to start of drilling is around 65 days, while it only takes 13 days on average for 

constructing an oil well. With respect to only horizontal fracking wells, the largest well 

may require over 9,232,230 gallons of water during its life. Clearly, on the average more 

water is required for horizontal fracking at 5,943,105 gallons per well whereas vertical 

drilling requires about 1,389,803 gallons of water. In Texas, vertical drilling is not as 

common as fracking. For this study, the truck traffic associated with conventional 

vertical drilling methods is excluded. The analysis of the days of the construction period 

of the sample is in Figure 5. 

 



 
30 

 

Table 4:Horizontal Fracking Wells Data. 

 

The quantity of sand used in fracking for each oil well must also be considered. 

According to the sample given by the RRC, only 13.18% of the total injected fluid mass is 

sand. Given the amount an average truck hauls, the amounts of water and sand 

supported during transport could be determined. Average hauling trucks can hold 20 

cubic yard of sand. Therefore, 13.18% of 5,943,105 gallons is 3,878 cubic yards. Dividing 

that by 20 gives an estimated 194 trucks transporting sand in and out of wells. After 

finding the weight of the materials being carried, the number of trucks necessary for the 

process of water supply and disposal can be calculated. This number is estimated for the 

API No. Water Vol (gal) Sand % Water % Approved Drill Start Drill Finish Wait Constr

28732619 7,820,526 13.58 82.58 12/4/2013 1/22/2014 1/29/2014 49 7

28732615 6,503,834 11.35 83.72 11/8/2013 2/18/2014 2/25/2014 102 7

28732621 6,020,994 12.78 83.05 12/13/2013 3/6/2014 3/13/2014 83 7

28732620 5,841,912 14.18 82.77 12/13/2013 3/6/2014 3/13/2014 83 7

28732617 7,264,716 13.27 86.71 2/26/2014 3/30/2014 4/5/2014 32 6

28732623 8,160,396 17.27 81.21 2/27/2014 4/5/2014 4/11/2014 37 6

28732628 7,243,404 13.93 76.96 3/6/2014 4/11/2014 7/16/2014 36 96

28732630 4,247,444 11.18 87.83 3/11/2014 4/16/2014 4/19/2014 36 3

28732635 5,382,036 11.22 87.69 4/9/2014 5/14/2014 5/17/2014 35 3

28732636 6,162,986 11.96 86.28 4/16/2014 5/27/2014 6/8/2014 41 12

28732626 4,544,240 11.64 86.62 2/28/2014 5/27/2014 6/8/2014 88 12

28732629 2,852,620 17.16 81.96 3/8/2014 6/10/2014 7/18/2014 94 38

28732616 4,210,796 14.41 83.51 4/4/2014 6/18/2014 6/25/2014 75 7

28732634 6,780,786 14.30 83.62 4/4/2014 6/18/2014 6/25/2014 75 7

28732641 7,037,294 12.12 84.97 5/6/2014 7/7/2014 7/14/2014 62 7

28732640 5,300,068 12.87 85.29 5/6/2014 7/7/2014 7/14/2014 62 7

28732632 9,232,230 11.65 89.44 3/15/2014 7/15/2014 7/21/2014 122 6

28732643 2,197,202 14.31 80.19 5/29/2014 7/17/2014 7/18/2014 49 1

28732646 5,286,204 13.21 83.83 6/9/2014 8/4/2014 8/8/2014 56 4

28732647 5,293,196 14.85 83.35 6/9/2014 8/15/2014 8/20/2014 67 5

28732646 7,140,462 11.29 84.94 6/9/2014 8/24/2014 9/10/2014 76 17

28732649 6,224,960 11.44 84.83 6/9/2014 8/24/2014 9/10/2014 76 17

Average= 5,943,105 13.18 84.15 65   13       

Horizontal Fracking Wells

Average Days
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entire oil well completion. Quantities of water and sand are given in Table 4, which 

shows the average water volume utilized for horizontal drilling is shown. Given the fact 

that most water hauling trucks have a 4000 gallons’ capacity, over 1,486 trucks are 

needed to transport water for a horizontal well. 

Generally, flow back of disposed water is about 20-50 percent of the total 

volume used in the injection process for fracking. For the purpose of this study, a near 

worst case assumption of a 40 percent flow back volume during the construction phase 

was used. After the initial oil well completion, lots of saltwater backflows with the oil or 

gas being fracked. This saltwater is mostly disposed of after the rate of flow back 

decreases. At that point, the saltwater is transported off site by use of trucks. Figure 5 

illustrates how the average daily truck traffic decreases after the initial two weeks of 

drilling. 

Figure 5: Well Production Truck Traffic. Source: Prozzi 2011. 
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The highest daily truck traffic experienced after 20 days of drilling would be up to 2-3 

trips. Transporting gravel is another small, yet relative element to consider. Gravel is important 

for its use to building access roads where rural roads are not usually found, such as long 

stretches of field. According to Kubars and Vachal (2014) study in North Dakota roads, 

approximately 80 trips are required to provide enough gravel to build access road. The last bit of 

heavy traffic generated due to the construction of new oil wells is traffic caused by transporting 

equipment. New York State Department of Environmental Conservation (1998) estimated the 

equipment truck traffic associate with the construction of a single gas well to be 200 truck trips. 

Given the low volume of equipment trips and lack of data on the companies providing the 

equipment, one could easily neglect this factor from the total count of truck traffic.  

Table 5 and Table 6 summarize the ESAL values generated with each activity 

related to a single oil well. From this information, truck traffic appears to be not as 

critical during the production phase. During construction, which takes roughly 13 days, 

calculations show that 7699 ESALs can be expected per well. On the other hand, 

calculations show that a much lower 1945 ESALs can be expected during the production 

phase, which can last up to a year Therefore, the construction phase occurs in a much 

shorter period of time and is much more damaging. For this study, truck trip generations 

for the construction phase with its loadings will be used in the model and linked with 

routes of travel to predict damages on the pavement.  
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Table 5: Oil Well Construction Truck Trip Generation. 

 

Table 6:Oil Well Production Truck Trip Generation. 

 

3.2.2 GIS Mapping Tool: 

The same method used for the Urban Model will be used in this model as well. 

The Network Analyst closest facility tool helps generate the shortest routes between an 

incident and a serving facility. In this case, the serving facility will be locations of sand, 

gravel, fresh water, and water disposal wells. The incidents that need to be served are 

going to be the wells. Depending on the data, linking ESAL values from the TTGTs with 

routes generated from the Network Analyst tool will show locations of heavy truck 

traffic, ultimately indicating where damages are going to occur. Focusing only on the 

construction traffic which occurs on a two-week period, the model inputs should be 

updated frequently to capture changes in truck movement patterns. On average, it 

takes more than 2 months for an oil well to be built after the approval of the oil permit. 

Purpose Volume ESAL (Value) ESALs

Water 1486 2.449 3639.214

Water Disposal 594.4 2.449 1455.6856

Bulk Sand 200 2.449 489.8

Gravel 80 2.449 195.92

Equipment/Other 200 9.59 1918

Total 2560.4 Total 7698.6196

Construction Activity per Well

Purpose Volume ESAL (Value) ESALs

 1st week 476 2.449 1165.724
 2nd week 196 2.449 480.004

Up to 60 days 90 2.449 220.41
after 60 days 30 2.449 73.47

Haul Product 2 2.449 4.898
Total 794 1944.506

Production Activity (Water Disposal)
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For estimation purposes in this model a period of study was determined to be 3 months. 

The tool is going to be developed using truck trip generation tables linked with route 

assignment by using origin-destination in ArcGIS’s network analyst.  

 

 In the following chapter two different models will be discussed based on an Oil 

and Gas Growth case and an Urban Growth case. The Oil and Gas Model is an example 

of a model where both the origin and destinations for the trucks are known, and the 

Urban Growth Model is an example where only origins or only destinations are known. 

The Oil and Gas Model was built for the Austin TxDOT district area for two periods of 

analysis, June-August and September-December of 2014. The model will use oil well 

permits data to forecast routes between oil wells and origins/destinations of facilities 

servicing the construction of an oil well. The other model will be based in Texas on 

Williamson County land use permits from July 2014 to July 2015. The model will have 

two maps, one for production traffic and one for construction truck traffic. Land 

developments will be connected to the nearest state highway to forecast truck trip 

routes.  
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CHAPTER 4: Results from Case Studies 

4.1 OIL AND GAS GROWTH MODEL CASE STUDY  

4.1.1 Austin District Oil and Gas Growth GIS Model Building: 

In this model, we focus on detecting changes in land-use that are specifically 

related to the oil and gas Industry development in the Austin TxDOT District 

jurisdictional limits. Figure 6 shows the Texas counties within the Eagle Ford Shale 

geological area. 

Figure 6: Eagle Ford Shale Counties. 

 

 Out of those counties, Lee and Bastrop are in Austin TxDOT District area. 

According to the US Energy Information Administration (USEIA, 2015) list of Top 100 US 

Oil Fields in terms of production, two fields from the Eagle Ford Shale formation are in 

the first and fifth ranking. It is also noted that the two fields’ production estimate sum is 
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nearly half the production of the top 10 production estimates in total. Moreover, Austin 

District of TxDOT has 11 counties, 3 out of those 11 had new oil well permits in 2014 

according to Railroad Commission of Texas database (TRRC). The Austin District of 

TxDOT experienced and still experiencing movement of trucks serving oil wells’ needs.  

 

4.1.2 GIS Data Sources 

The first step in this model to is to determine the data that can be gathered and 

implemented to follow these truck travel patterns. For this model the list of essential 

source locations is as follows: 

1- Oil wells. 

TRRC is responsible for regulating oil and gas permits in Texas. It is the 

agency that monitors and issues oil well permits so it the right source of data for 

this model. The RRC online website was used to gather information regarding all 

the permitted oil wells in the area under the jurisdiction of the Austin District of 

TxDOT. Oil well names, data, and ownership information is available in Excel 

format. However, these Excel files now need to have geographic coordinates to 

know the location of the wells. Along with the well information in excel files are 

the well API number, where API stands for American Petroleum Institute. The 

API number is unique for each well in the United States and links it to its X and Y 

geographic location. The coordinates of those wells must be either purchased or 

discovered individually by API number using the “Legacy Viewer GIS Tool” on the 

RRC website. Adding X and Y columns in excel and copying and pasting 
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longitudes and latitudes from RRC website generates tables that are readable by 

ArcGIS. By studying Caldwell, Bastrop and Lee counties, the model should include 

all the surrounding counties as well as there will be some oil wells being served 

by external facilities, or some facilities might service external oil wells. The excel 

files should include: Caldwell, Bastrop, Lee, Burleson, Fayette, Gonzales, 

Guadalupe, Milam and Washington counties. In order to capture the 60-day 

period that on average is the time from approval until construction begins, 2 

periods of study for 3 months were chosen for permits approved on June to 

August, and September to November 2014.  

2- Fresh water wells. 

Data describing the sources of water supply were obtained from the 

Texas Commission on Environmental Quality (TCEQ) that takes responsibility for 

all aspects of planning, permitting, and monitoring. For instance, TCEQ maintains 

datasets for the water in Texas, and this allows for easy access to shapefiles. 

Included in the model is the shapefile of “Public Water System Wells & Surface 

Water Intakes.” This particular shapefile gives the locations of water wells that 

are most useful to the fracking process. 

3- Saltwater disposal wells. 

 GIS locations for saltwater disposal wells were gathered from the TRRC website 

the same way as the oil wells. However, disposal wells don’t have approval 

permit days, only the active disposal wells were taken into account. The data 

was retrieved on April 1, 2015.  



 
38 

 

4- Quarries.  

Quarry locations supplying sand and gravel were provided by TxDOT Project 

Advisor Rhonda Roundy, CST. Active quarries were given in the set of data for 

the Austin TxDOT District Area, and the surrounding districts as well.  

5- Roadway network:   The roadway network is one of the most important aspects 

to this project, because it geographically describes the potential paths for trucks 

to travel.  A Shapefile representation of the roadways is used to connect all 

routes and form a network in the ArcGIS software. The roadway Shapefiles were 

sourced from Katie Kam, a researcher at the Center of Transportation Research. 

The file included all the roads in Texas that are maintained by TxDOT in addition 

to some local roads as well.  

6- Texas Counties: 

this will serve as the model base map where all the analysis will be based, it will 

show the geographical political borders between counties. It will also be used to 

show the study area. The Texas county boundaries map can be found in Texas 

Natural Resources Information System (TNRIS) website. The file name is All 

Boundaries found under Maps & Data > Data Catalog > Boundary > Startmap 

Boundaries.   

 

4.1.3 Austin District Oil and Gas ArcGIS Implementation:  

ArcGIS was used to layer the information that had been retrieved. Each location 

was exported as a Shapefile into ArcGIS providing an extensive model. The majority of 



 
39 

 

the elements in the model require frequent updates. The RRC oil well permit data, for 

example, is the main layer used in mapping, and this data must be collected for the time 

period of analysis desired. As stated to build this model, oil well permits for the two 

time periods: June to August and September to November 2014, were used. The water 

wells can be updated by using the Shapefiles from TCEQ. Disposal wells should be 

checked periodically for any updates, but these files are unlikely to change as 

frequently. In both time periods, the disposal wells had concurrent data. Moreover, 

quarry information has the least probability for finding available updates since a small 

number of quarries in the model exist compared to the other data. 

 The first step is to connect the files that have all the GIS data with ArcMap. In the  

ArcMap main window, on the right side there is a “Catalog” window that shows the files 

connected to the software. If “Catalog” window is not visible, one may use the ArcMap 

main window top bar > Windows > click on Catalog to activate it. Right click on Folder 

Connection and click on Connect to Folder, navigate to the GIS data folder and click 

connect. Now add the counties shapefile by dragging the shapefile from the right 

window into ArcMap main window. The counties map has a specific coordination 

system that needs to be changed to fit the study area projection system. ArcGIS tools 

are stored in the ArcToolbox window, for each tool a step-by-step guide will be provided 

to show how the analysis was done. “Project” tool will be used now and the guided 

process is as follows:  
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The tool is found in: ArcToolbox > Data Management Tools > Projections and 

Transformations > Project.  

Input Dataset or Feature Class: StratMap_County_Poly  

Output Dataset or Feature Class: Counties 

Output Coordinate System: NAD_1983_StatePlane_Texas_Central_FIPS_4203_Feet 

RUN 

The output has the counties projected to the Central Texas projection system. 

Now manually selecting the counties in the Austin District of TxDOT would be ideal to 

differentiate between the study area and the surrounding counties. This can be done by 

clicking on the “Select Feature” button then holding the “Shift” key on the keyboard and 

manually selecting each county. The selected counties then can be exported to a new 

layer by right clicking on the Counties shapefile > Selection > Create Layer from Selected 

Features and now the based map for the model is ready. The next step is to import the 

oil shapefiles. Oil well data for the two time periods are in Excel format. Exporting XY 

coordinates can be done by changing the excel file format to “Microsoft excel 97-2003 

worksheet (xls)” for ArcGIS to be able to read the tables. The “Make XY Event Layer” is a 

tool that would be used to create a point layer from XY data tables. Following is a guide 

to use the tool “Make XY Event Layer”  

 The tool is found in: ArcToolbox > Data Management Tools > Layers and Table View > Make XY 

Event Layer.  

XY Table: OilWells (For oil wells in the 1st period (June-August 2014) OilWells2 is the 2nd 

period) 
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X Field: X (The column name that was created in the excel files for Longitude) 

Y Field: Y (Latitude)  

Layer Name or Table View: OilWells (Name of shapefile output) 

Spatial Reference: NAD_1983_StatePlane_Texas_Central_FIPS_4203_Feet (this is used 

because it contains most of counties in the study area: Bastrop and Lee. However, 

Caldwell is on South Central 4204); RUN; Output:  

Figure 7: Oil Wells (Period 1). 

 

 The output in figure 7 shows locations for oil wells converted from Excel files into 

ArcGIS shapefile and projected to the “NAD 1983 StatePlane Texas Central FIPS 4203 

Feet”. The same method works for oil wells 2 (the second three month time period) and 

disposal wells. Quarry locations and fresh water wells are shapefiles, shapfiles are 
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readable by ArcGIS but these shapfiles need to be projected so that their coordination 

system matches the model coordinate system. The “Project” tool that was used to 

project the counties shapefile can be used for the projection of quarries and fresh water 

wells as well. The model now should have oil wells, oil well 2, disposal wells, quarries 

and fresh water wells. 

The next step after importing source information data into ArcGIS is creating a 

road network.  Having a road network, one can implement network analyst’s closest 

facility tool to find the route assignment. The first step is to activate the network analyst 

extension: ArcMap main window top bar > Customize > Extensions… > click on Network 

Analyst to activate it. Adding Network analyst toolbar as follows: ArcMap main window 

top bar > Customize > Toolbars > click on Network Analyst to add it. Following is a guide 

on how to create/build a network dataset: 

Navigating to the network shapefile in Catalog and right clicking on it, clicking on “New 

Network Dataset…” will open a window to help build a network dataset. Following is a 

guide for each window: 

1- Enter a name for your network dataset: TexasRoads 

2- Do you want to model turns in this network? YES 

3- Check that connectivity policy is end points 

4- How would you like to model the elevation of your network features? NONE  

5- Make sure that the units are: Miles 

6- Next 
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7- Do you want to establish driving direction settings for this network dataset? 

Depending on the user output needs, for this model we chose YES.  

8- Finish 

The output will have two parts, the edges which are the street lines and 

junctions which represent all the junctions in the network. In this model only the street 

lines will be needed. Figure 8 shows the inputs of all the data in this model.  

Figure 8: All Model inputs. 

 

Oil wells, disposal wells and quarries are locations in the study area parameters. 

However, TCEQ freshwater locations are in the State of Texas. This will generate a 

problem when trying to find the closest water well to an oil well. The TCEQ file contains 

17206 water wells, clipping the data to our area parameter is needed for the software 
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to calculate routes efficiently and only include inputs that are considered important. 

Manually selecting these counties: Caldwell, Bastrop, Lee, Burleson, Fayette, Gonzales, 

Guadalupe, Milam, Washington, Travis, Williamson and Hays will cover the surrounding 

area. Exporting these selected features as a layer will generate a layer that we want to 

use in the next step. “Clip” is a tool that is used to trim the shapefile based on the 

boundaries of another. In other words, the FreshWater shapefile will be clipped based 

on the surrounding counties shapefile. The output will only have FreshWater wells that 

are in the surrounding counties boundaries. A guided illustration is as follows:  

The tool is found in: ArcToolbox > Analysis Tools > Extract > Clip  

Input Features: FreshWater  

Clip Features: SurroundingCounties 

Output Coordinate Class: FreshWater1; RUN  

Table7 shows a breakdown of the steps needed to set up the model. 

Table 7: ArcGIS Tools For Creating The Model. 

 

Tool location Tool Inputs Output Notes

DMT>Projections and 

Transformations>
Project Startmap_County_Poly Counties

DMT>Layers and Table 

View>

Make XY Event 

Layer

Inputs: Oilwells, 

(OilWells2 2nd run) 

All_Routes_

EndPoints

Spattial Reference: 

NAD_1983_StatePla

ne_Texas_Central_FI

PS_4203_Feet 

ArcCatalog

Build a new tool 

(Right click on 

Roads Shapefile) 

TxDOT Roads TexasRoads
Model U Turns: Yes 

Units: Miles

Analysis Tools>Extract Clip TCEQ_PWS FreshWater
Clip Feature: 

SurroundingCounties
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The next step is to find the shortest path between the origins and destinations. 

Many points can be selected as incidents or facilities. The definition of incidents in 

ArcGIS is the location that needs to be served.  For this case, the oil wells are incidents 

or important factors on which to focus more attention. Facilities, on the other hand, 

serve the incidents so quarries, disposal wells and water wells will be the facilities. 

Running the tool will generate the route assignments that are later going to have 

specific ESAL values added to identify locations of heavy loadings compared to other 

locations. A guide on how to use Closest facility function for quarries linked with oil 

wells for the 1st period is explained below: 

On the Network Analyst toolbar click on the Network Analyst dropdown menu 

and choose new Closest Facility. Click on the Network Analyst Window button to 

activate the tool window that will be located on the left side of the main ArcMap 

window. Right click on Facilities > Load locations… > Load from: Quarries (Make sure 

location position is set based on “Use Geometry” 10 Miles, to connect the facility to the 

nearest network lines within a 10-mile radius) Click OK to load facilities. The same 

method can be followed to load OilWells into incidents. Now the facilities and incidents 

locations are loaded, click on the solve button in the Network Analyst toolbar to find the 

shortest paths. Figure 9 shows the output of the network analyst tool with the shortest 

routes between quarries and oil wells (1st period).  
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Figure 9: Network Analyst: Closest Facility Output: Quarry to Oil Wells. 

 

Figure 9 shows the shortest paths between OilWells1 and Quarries. The routes 

are connecting each oil well to the nearest quarry. Moreover, running the tool for each 

route will generate 6 routes: Quarry to OilWells (QO), Quarry to OilWells2 (QO2), 

Disposal to OilWells (DO), Disposal to OilWells2 (DO2), Water wells to OilWells (WO) and 

Water wells to OilWells2 (WO2). These 6 routes have different ESAL values associated 

with each route. Adding an ESAL value field in each routes attribute table is crucial in 

this step for further analysis. The guide below shows how to add ESAL values for each 

route. 

 The first step is to right click on Routes in each closest facility output drop down 

menu > Data > Export Data… > and name each route accordingly. Example, Quarry to 

OilWells will be named “QO”. Right click on QO > Open attribute table > Table Options > 
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Add field… > Name: ESAL , Type: Double (Double is used for numerical values) then OK. 

To add values for the field, right click on ESAL field > Field Calculator > then type 686 in 

the “ESAL=” open box. The value 686 is the ESAL value associated with quarry trips in 

QO and QO2, 1456 will be used with DO and DO2, 3640 will be used in WO and WO2.  

Analysis Method 1: 

To classify routes in order of their importance, or to know where the highest 

ESAL loading will occur, certain tools in ArcGIS can be used. One of those tools will 

arrange routes in order of the ESAL loading and represent them with a proportional 

width of line. For example, Water well to Oil wells (WO) has the highest ESAL loading of 

3,640 per route. Line size of 8 will be used for the WO routes. The second highest ESAL 

loading is Disposal wells to Oil Wells (DO) that have an ESAL loading of 1,456 per route. 

Line size 6 will be used for this route. Leaving Quarry to Oil wells (QO) with a line size of 

4 for their 686 ESAL loadings. Figure 10 shows the breakdown of routes and their line 

sizes. Different colors will be assigned for each route to make it easier to visually 

differentiate. Routes from the second study period will have 1 size smaller lines. This 

means WO2 will have size 7, DO2 will have size 5 and QO2 will have size 3. Figure 10 

shows what the model would look like with different widths and colors.  
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Figure 10: All Shortest Path Routes Between Incidents and Facilities. 

 

Figure 10 shows all the shortest routes from incidents and facilities in the model. 

each trip purpose in each study period has a specific width and color. It is really hard to 

say which areas are of concern from the first look at the model. However, further 

analysis should be done to help get to that point. The first step is to eliminate routes 

that are not going to be important. A tool in ArcGIS lets the user eliminate routes with 

one trip only. The “Intersect” tool will generate an output that contains intersected trip 

routes. This means if there is only one trip in a specific route, that does not intersect 

with any other trip route, this trip will be eliminated. Running the tool will help in the 

process of eliminating areas that are not of concern.    

Example of running the intersect tool for one of the routes is illustrated below.  



 
49 

 

 

The tool is found in: ArcToolbox > Analysis Tools > Overlay > Intersect 

Input features: QO 

Output: Quarry; RUN; Output:  

Figure 11: Quarry Routes with 2 or more trips involved. 

 

 Figure 11 shows the output of running the Intersect tool on QO routes. Running 

the other 5 routes on the same tool is needed now to eliminate all other non-important 

truck effects. Figure 12 shows the final output before manually analyzing each county in 

the Austin district. The model now contains only routes with 2 or more trips in each 

route. 
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Figure 12: All routes with two or more trips overlapping in the same route. 

 

Comparing Figure 12 to Figure 10 shows a significant reduction in the number of 

routes. This reduction is much needed at this point before analyzing each route since it 

saves time for users of the model. Further visual inspection of each county is needed to 

determine which routes seem important enough to calculate their ESAL values. The first 

step is to divide the analysis area by county and then follow simple steps to eliminate or 

examine routes. Rules of thumb for this analysis might include the facts that WO routes 

carry 3640 ESALs which is more important than 5 routes of QO, given that QO carry 686 

ESALs, and 2 routes of DO that experience 1456 ESALs. Since we already eliminated 

routes with one WO trip and we only included 2 or more WO trip routes, then any 

routes with 10 QO trips or 4 DO are automatically not important as well. Starting from 
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Caldwell county, by zooming in it is obvious that there are 4 areas of concern in this 

county as shown in Figure 13.  

Figure 13: Caldwell county critical segments.

 

Each route should be investigated individually by zooming in on the route and 

selecting each route, opening the attribute tables for each route type, and manually 

calculating ESAL loading in the segment by multiplying the ESAL number by how many 

trips are using the segment. Selecting a segment and opening the attribute table for its 

route, a number of selected features will appear in the lower part of the tables. Another 

identification of the number of the selected feature, is in the lower left corner of the 

general software window. After selecting a segment in the model a small line will pop up 

in the lower left corner showing the number of selected features.  
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Figure 14: Caldwell segment #1 

 

Figure 14 shows segment #1 in Caldwell county which includes 3 routes that 

might be of concern. These routes are only QO routes meaning that the only ESAL values 

associated with these routes is 686. The part containing 10 QO routes will automatically 

be out of concern since its less than the 2 WO routes. The remaining routes will have 

values of 15x686=10290 ESALs and 25x686=17150 ESALs.  

 Some routes will have a combination of OQ, OD and OW overlapping. In these 

areas the user should activate each route class by itself and then identify how many 

trips in this segment are associated with this route class. Caldwell segment #2 shows the 

3 route classes overlapping which makes it hard to identify how many trips are in each 

route unless it was studied by class and then adding the total ESAL value for the whole 

segment. Figure 15 shows Caldwell segment #2 and how many trips of each route.  
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Figure 15: Caldwell segment #2 

   

Multiplying numbers of trips for each route by its ESAL value and adding all ESAL 

values will give the user to total ESAL value generated in this segment. This segment 

ESAL value is: 5x686= 3430 + 5x1456=7280 + 7x3640=25480, Total= 36190 ESALs.  

Figure 16: Caldwell segment #3 

 

Figure 16 shows Caldwell segment #3 that has 3 OW2 paths, 3x3640=10920 

ESALs. In Figure 17 Caldwell segment #4 has 5 OW&OW2 paths or 5x3640=18200 ESALs. 
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In section *, on the higher right corner of the figure, the quarry route holds 5 routes 

only which is less important than one water route and section **, the route containing 

the disposal is insignificant because of its small size. 

Figure 17: Bastrop critical segment 

 

 It is obvious that Lee County would have the highest truck traffic in this model. It 

was predictable based on the oil well counts, given that Lee has 72 oil wells compared to 

8 in Bastrop and 28 in Caldwell. Bastrop county was studied and the worst case scenario 

route had an ESAL value of 18,200.  In Lee County, there are more than 3 areas of 

concern but going through each area, Figure 18 shows the highest ESALs value for the 3 

areas of concern. Figure 19, Figure 20 and Figure 21 shows the ESALs values for each 

area.  
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Figure 18: Lee critical segments 

 

Figure 19: Lee segment # 

1  
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Figure 20: Lee segment #2 

 

Figure 21: Lee segment #3 

 

Analysis Method 2: 

Another way to classify areas of concern is through spatial analysis extension. 

The extension, just like the Network Analyst needs to be activated before the analysis is 

made. First step is to find the line density in each of the 6 routes. According to ArcGIS 
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resource center, line density tool calculates polyline feature density by multiplying the 

line length by the “Population field” and dividing it by the area of grid cells. Usually the 

grid cells areas are set by default for lines generated by the network analyst outputs. So 

the variables here are “Population field” and length of line. Figure 21 shows how the 

tool works. 

Figure 22: Density Line Tool. Source: ArcGIS Resource Center 2011. 

 

ESALs will be the variable that will be used as the “Population field” to generate 

how many repetitive ESALs are applied to each segment in comparison to the rest of the 

route segments. Length of the line will be calculated spatially by the tool. An example of 

running the Density tool for one of the routes is illustrated below.  

The tool is found in: ArcToolbox > Spatial Analyst Tools > Density > Line Density 

Input Polyline features: QO (Quarry to Oil well) 

Population field: ESAL; RUN; Output:  
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Figure 23: Quarry to Oil routes: ESAL Density

 

Figure 23 shows the variation of the density of ESAL values associated with 

Quarry to Oil routes. The output shows the ESAL density values as black when it is high, 

white when it is low. Running the density line tool for the remaining 5 routes will 

generate 5 outputs. At this point we have 6 different areas of concern for each route. 

The next step is to join these 6 outputs into 1 output that shows the general areas of 

concern taking into account all the inputs from the origins to destinations and how 

heavy the truck traffic travelling in these routes will be and finally shows where there 

should be concern.  

 The weighted sum tool can help join the 6 density line routes generated in the 

previous step. According to ArcGIS Resource Center (2011), the tool combines multiple 

raster inputs, representing multiple variables to one raster output. The output will show 

the weighted sum of all the inputs, this means that the output will show the sum of 
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inputs depending on their ESAL values importance from high to low. This tool is ideal in 

our study since we are concerned with more ESAL loaded routes.  

The tool is found in: ArcToolbox > Spatial Analyst Tools > Overlay > Weighted Sum  

Input Polyline features: QO, QO2, DO, DO2, WO, WO2; RUN; Output:  

Figure 24: All Routes ESAL Density

 

 All routes now are accounted for in the model, in Figure 24 the user can tell that 

there’s a high density of ESAL values in Lee county. The final output helps the engineer 

to locate where attention is needed, by following this output the highest area of 

concern is located in Lee county. Exactly like what the method of “Widths and Colors” 

predicted. However, these two methods can work greatly depending on the choice of 

the user. In this thesis there was a process of building an accurate tool, so visually 

inspecting each county by different widths and colors generated areas of interest based 
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on exact ESALs. The spatial analysis method is very helpful for engineers who are 

concerned about time spent on the model and wanting a general area of concern in a 

specific county.  The user can go back and forth with both tools to double check results.  

Analysis Method 3: 

 There is a third technique to follow to know the location of where the most 

damages are going to occur. This technique can be tricky and the process is longer than 

the previous two but the upside of it is that it breaks down the importance of segments 

based on ESAL values. The first step is to merge all the routes, QO, QO2, DO, DO2, WO, 

WO2 into one single route and name it “All_Routes”.  The “Merge” tool can be found in 

the geoprocessing drop down menu. After merging the routes, the user should create 

points where the lines end. This will help to know where routes start and end, on the 

merged network of routes. Naming this output “All_Routes_EndPoints” will be ideal 

since the model will require more shapefiles to be created, so naming at each step will 

help to differentiate the inputs and outputs. Back to the “All_Routes” merged file, we 

use the  “dissolve” tool to dissolve all the routes and come up with one route that we 

are going to use as the base map for further analysis. The output file should be named, 

“All_Routes_Diss”. The base map of routes needs to be divided every time there is a 

different route experience, or in another words it needs to be divided based on where 

intersections of travel activities are happening. The “All_Routes_EndPoints” shapefile 

contains these intersections of travel activities, as it tells the end or start of each trip. A 

tool that splits line based on points is called “Split line at point”. “All_Routes_Diss” and 

“All_Routes_EndPoints” are the inputs for the tool “split line at point” that will generate 
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a new shapefile, “All_Routes_Split”, that have spatial segments of where the routes are 

intersecting and also contains the single trip routes. This tool is important because it will 

let the software know that there might be a chance of trips occurring on this route and 

it does have a value, furthermore these split routes will be used to calculate how many 

trips are using each segment and what are the ESAL values associated with each. The 

next step is to spatially join “Total ESALs” to each route, QO, QO2, DO, DO2, WO, WO2, 

and add a field to sum the ESAL value experience in each segment.  

 The first step is to right click on “All_Routes_Split” > Join and Relates > Join… 

Figure 25 shows the window and what options to choose to successfully spatially join 

the routes. 

Figure 25: Join Data window inputs 
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The output file would be named automatically “Join_Output” no need to rename it since 

this is not the final output and, the next step is to Spatially join “Join_Output” with QO2, 

this will give an output of “Join_Output2”. Following the same method will lead to a 

“Join_Output6” this file is the final output as it holds all the ESALs values. The last step is 

to add a field in the attribute table and name it “Total_ESAL”. Using the field calculator 

tool in the attribute table, this equation must be used to sum all the ESALs in each 

segment. Total_ESAL= [Sum_ESAL]+ [Sum_ESAL_1]+ [Sum_ESAL_2]+ [Sum_ESAL_3]+ 

[Sum_ESAL_4]+ [Sum_ESAL_5]. The Total_ESAL field now has ESAL values of all the 

unexpected traffic that will most likely travel in this 6 month sudy period. The user of 

the software can generate a visual output depending on the ESAL value. Figure 26 shows 

different levels of ESALs using a 50,000 ESAL interval. Figure 27 shows only routes in the 

Austin District area that are going to experience ESALs of more than 20,000. Table 8 

shows the steps to produce the output.  
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Figure 26: Final output showing exact ESAL numbers on each route

Figure 27: Caldwell, Bastrop and Lee counties additional unexpected ESAL values. 
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Table 8: ArcGIS analysis method#3 step-by-step tool guide. 

 

4.2 URBAN GROWTH MODEL CASE STUDY  

4.2.1 Williamson County Urban Growth Model Building:  

Texas is the 2nd highest state in terms of VMT in the US with total truck VMT with 

more than 2 hundred billion VMT (USDOT, 2014). The ongoing truck traffic growth in 

Texas is directly related to land use changes. In 2014, Williamson County was ranked 

one of the three fastest growing counties in the nation by the US Census (US Census, 

2015). Williamson county is located in Central Texas on the I35 corridor, this makes the 

county prone to Industrial interest since most industrial plants are located to simplify 

logistics. More people moving to the County generate more business interest. Officials 

in such a small county usually are not prepared for sudden growth, especially in their 

counties’ infrastructure needs. In this model, Williamson County was chosen because of 

the ongoing urban growth as this county represents the best location where the model 

can be implemented. This model will generate ESAL based truck trip generation and try 

to predict truck travel patterns, producing a model that can follow urban growth 

impacts.  

Steps Tool location Tool Inputs Output

1 DMT>General> Merge QO,QO2,DO,DO2,WO,WO2 All_Routes

2 DMT>Features> Feature Vertices To Points All_Routes All_Routes_EndPoints

3 DMT>Generalization> Dissolve All_Routes All_Routes_Diss

4 DMT>Features> Split Line At Point
Feature:All_Routes_Diss 

Point:All_Routes_EndPoints
All_Routes_Split

5 Join and Relates Join>All_Routes_Split QO Join_Output

6 Join and Relates Join>Join_Output QO2 Join_Output1

7 Join and Relates Join>Join_Output1 DO Join_Output2

8 Join and Relates Join>Join_Output2 DO2 Join_Output3

9 Join and Relates Join>Join_Output3 WO Join_Output4

10 Join and Relates Join>Join_Output4 WO2 Total_ESAL
*DMT=Data Management Tools
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The base of this model is Williamson county building permits GIS data that shows 

the location of future developments. These data will be used to develop a truck flow 

impact model. The data is compiled of locations of future developments that are 

approved by the county. It will be divided into three categories: residential, commercial 

and industrial. Truck flow will be directly dependent on the size of the development 

generating different levels of importance, bigger development will generally attract 

more truck traffic in comparison to other developments in the same category.  

Certain assumptions are made since it is really almost impractical to find origins 

and destinations of all truck trips in this model. Trucks are assumed to have the 

maximum legal weight of 80Kips, although this is overestimating and heavy since some 

trucks have the trailer filled out volume wise. Following the production tables formed in 

the methodology section, construction rates will be the same. However, production 

tables will be converted to fit an annual estimation, making the model valid for one year 

and can be updateable based on source data updates. Assuming industrial, 

manufacturing and warehouse land uses only work 5 days a week, an average of 250 

days per year is when they are sending/receiving trucks. Grocery stores and residential 

land uses are going to be active 365 days a year. Tables 9 and 10 show the rates that are 

going to be used in the production and construction models.  

Table 9: Construction Truck Trip Generation  

 

Purpose ESAL (Value) ESALs/Trip

All Purposes 1 /1000 SF 2.449 2.449
Residential 2 /House 2.449 4.898

Construction Activity Rates
Volume

*Average house lot size is 18,000SF, Use 15,000SF
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Table 10: Production Truck Trip Generation

 

4.2.2 GIS Data Sources:  

1- Roadway network and Texas Counties:  The same sources as the Oil and Gas 

model was used. (the roadway Shapefile provided by Katie Kam, a researcher at 

the Center of Transportation Research) and the Texas counties boundaries 

shapefile from Texas Natural Resources Information System (TNRIS) database.  

2- Williamson county new developments: This shapefile was obtained from Patrick 

Hughes, a civil engineer at Williamson County who is responsible for GIS and 

mapping. This file is the base of this model, as every GIS based models, data is 

the cornerstone of the study. The shapefile contains 493 inputs:  

A- 242 inputs with no “Approval Date”  

B- 158 inputs with approval dates from 1998 to June 2014 

C- 93 inputs with approval dates from July 2014 to July 2015 (this is the data 

that is going to be used in this model) Table 28 shows statistics of the data in 

terms of Acres and the frequency distribution of the 93 inputs. 

Purpose Time (Days) ESAL (Value) ESALs/Trip/year

Industrial 0.38 /1000 SF 250 2.449 232.655

Grocery store 0.51 /1000 SF 365 2.449 455.88135

Manufacturing 0.35 /1000 SF 250 2.449 214.2875
Warehouse 0.44 /1000 SF 250 2.449 269.39

Residential 0.011 /1000 SF 365 2.449 9.832735

Volume

Production ESALs Rates
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Figure 28: Williamson one year data sample acre statistics

 

4.2.3 Williamson County Urban Growth ArcGIS Implementation:  

 Model creation is begun  in ArcMap by adding TexasRoads, counties and 

Williamson county shapefiles. Projecting all files to “NAD 1983 StatePlane Texas Central 

FIPS 4203 Feet” must be done before any analysis is made. Exporting Williamson county 

from counties can be done by selecting it manually from counties and creating a layer 

for the selection. A new shapefile containing the data related to the study period must 

be created. Right click on the Williamson county new developments shapefile > open 

attribute table > choose the data contained in the study period based on the approval 

date > right click again on the Williamson county new developments shapefile > Data > 

Export Data... and save the data as July14-July15. The data contains Acres, names of 

developments and approval dates. Acres will be the variable used to generate ESAL 

values. However, we also need to breakdown the data based on land uses.  

 One must add a field to the attribute table and arbitrarily name it SF (square 

feet) to convert Acres to SF. This can be accomplished by the following:  Right click on 

the field > click on field calculator > SF= 43560*Acres then Ok. The other obstacle is that 

there is no column that states which type of development this is so a manual inspection 
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of each name of development by googling each name to determine the activities 

associated with the development, a column named: “category” was then added to the 

attributes table and the results came out like this:  

A- 85 inputs: Residential development 

B- 5 inputs: Other development:  

i. Country club. 

ii. Cemetery. 

iii. Fire Station. 

iv. 2 unknown inputs 

C- 1 input: Industrial development: Robbert Madison Industries  

D- 2 inputs: Commercial development: “Pensco Trust” and “Braun Commercial”  

The next step is to break the July14-July15 shapefile into 4 different shapefiles in terms 

of land uses, this can be down the same way July14-July15 was extracted from the 

original shapefile. Each new shapefile is now a polygon based shapefile, in order to run 

the network analyst tool, each shapefile needs to be a point based shapefile. Switching 

from polyline to point can be done following these steps:  

The tool is found in: ArcToolbox > Data Management Tools > Features > Feature to Point 

Input Features: Residential 

Output: Presidential 

RUN 

Now Industrial, Warehouse and Other should be converted in the same manner. The 

model now should look like this.  
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Figure 29: Point location of land developments

 

 The next step is to find the shortest paths that trucks most likely will follow. 

Network Analyst tool is now to be used, following the same step from the Oil and Gas 

model will lead to 2 new shapefiles in the model. Land uses category shapefiles will be 

the Incidents in this model, but the missing piece of the puzzle is where are the trucks 

travelling to/from? The best assumption to be made at this point is that trucks most 

likely going to travel State Highways then to their destinations, or they might come from 

their origins thru State Highways then using local roads to their destinations. Finding the 

shortest path between the incidents and the State Highway junctions can be done in the 

following steps:  

TexasRoads contains the breakdown of the streets based on their classification. 

Manually select streets that are Interstate highways, State Highways or US highways (IH, 

SH and US) and export this layer. TexasRoads_Junctions contains all the junctions in the 
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State of Texas. Clip The shapefile based on the Williamson county boundaries to show 

junctions located in Williamson only. Now we are only concerned with junctions that are 

on the State Highways. ArcMap main window top bar > Customize > Toolbars > Editor > 

Start Editing. Now manually delete all the junctions that are not included on the State 

Highway shapefile. We are now left with points that represents junctions with State 

Highway and the model is ready for network analysis.  

 Loading PResidential shapfile as incidents, and TexasRoads_Junctions as facilities 

and running the Network Analyst closest facility tool will generate routes connecting 

Residential developments to the nearest State Highway. The same method should be 

done for all other lands uses. Export each route into a shapefile and name the routes 

RResidential, RIndustrial, RWarehouse and ROther. The routes now have attribute 

tables that are missing their SF fields. Right click on Residential > Joins and Relates > 

Join… Figure 30 shows what the join window must look like. 
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Figure 30: Join data window inputs: to join routes to points' attribute tables. 

 

 The same joining method must be followed for all the Routes in order to have 

the SF field included in the analysis. The next step is to save all the data inputs in one file 

in Catalog, then export the routes as new shapefiles to have the joined values 

connected permanently. Figure 31 shows the output of Network Analyst. 
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Figure 31: All inputs with output of shortest paths between developments and nearest state highway

 

At this step, all the inputs are in the model ready for the analysis. However, this 

model has two different truck trip generation tables. Production trips have an annual 

basis, while the construction trips will be instant, non-repeatable and can take up to one 

year than vanish. In Catalog, one might add another folder, copy and paste all the 

shapefiles and name it Production, rename the current folder Construction producing 

two models that can be separately manipulated. The only difference between the 

models will be the ESAL values. In the next steps are an explanation of  how to add ESAL 

values for both models: 

Construction: 
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Right click on RIndustrial > Attribute table > Add Field > ESAL (Double). Now 

navigate to the ESAL field right click > Field Calculator > ESAL: (SF/1000)*2.449 

then Ok. The equation is valid for ROther and RWarehouse. However, 

RResidential equation is ESAL: (SF*2/15000)*2.449. Now ArcMap will generate 

ESAL values based on the SF values. At this step we connect the truck trip 

generation tables that were built on 1000SF variables with routes built from 

ArcMap.  

Production:  

RIndustrial> ESAL: ( SF/1000)*232.655 

RWarehouse> ESAL: ( SF/1000)* 269.39 

RResidential> ESAL: ( SF/1000)* 9.83 

ROther was excluded from this model due to variations in the productions trip 

data.  

Oil and Gas model Analysis Method 2 and 3 would be done now to determine locations 

of maximum loadings. Following the same steps in the Oil and Gas models will have the 

following outputs.   
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Production output maps: 

Figure 32: Spatial Analysis of the Production truck traffic (Method2) 

 

Figure 33: Production truck traffic Total ESAL values (Method3) 
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Construction output maps: 

Figure 34: Spatial Analysis of the Construction truck traffic (Method2) 

 

Figure 35: Construction truck traffic Total ESAL values (Method3) 
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CHAPTER 5: Discussion 

 This model predicts truck trips and associated ESAL values for specific highways 

resulting from land use changes including land development, re-development or mining 

activities. The model output identifies routes that represent the truck travel routes and 

ESAL values associated with that trip route. Different trip purposes generate trips 

overlapping or travelling in different directions. The model offers three analysis 

methods and ArcGIS provides the tools for users to build the desired analysis.  

 Analysis method #1: shows all the routes in the model, each route is assigned a 

specific width and color, meaning that each trip route associated with a specific ESAL for 

its trips can have a color and width. In the Austin District petroleum case study, only 3 

ESAL values for 2 study periods were used, leading to a total of 6 values of ESALs 

assigned to each trip route. Flexibility of this case study is high compared to the 

Williamson county case study, since it has less variability of ESAL values, only 3 different 

ESAL values were included. This is due to the fact that ESAL values were only dependent 

on the travel activity, in this case it was water, disposal and quarry based trips. On the 

other hand, Williamson county model’s ESAL values were dependent on area size which 

produced a huge variation of ESAL values and automatically eliminated the feasibility of 

analysis method #1. This analysis method is basic and does not require extensive 

knowledge or software skills. The output of this method can interoperated by manually 

adding each overlapping route’s ESAL value to find the sum for the intersected segment.  

 Analysis method #2: This analysis method saves time for the user in manually 

looking into each segment, and identifying the “critical” segments. This is based on 
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spatial analysis of ESALs of overlapping routes that have high total numbers of ESALs. 

The method is ideal for users with moderate knowledge of the software, and provides 

an efficient way to manually add fewer segments and only focus on critical zones.  

 Analysis method #3: Although this analysis method can be hard for the user to 

implement in the software, it provides exact numbers of ESAL values from the first run. 

It is the most efficient process and works on both case study examples as it does not 

take into account effects of the variation in ESAL values and it automatically sums 

overlapping ESALs and single trip route ESALs.  

The Austin District case study was the simplest form of implementing the model, 

it had all the inputs the model needed: TTGTs built on previous research and GIS data of 

origins and destinations. The analysis was made using three different methods. 

Depending on the user capabilities and desired output, one can choose any of the three 

methods.  

The reason behind 3 Analysis methods is to provide accurate estimates of ESAL values 

and to make sure the analysis of the inputs was correctly made. By comparing the 

results from the three methods in for Austin District Case Study: we find out that the 

critical segments are all in Lee County and have an estimate of 120,000 ESALs.  This was 

predictable due to the abundance of oil wells in Lee county, compared to Caldwell and 

Bastrop Counties. The model successfully predicted the linear relationship of oil wells 

and route loadings, but the problem occurs, as stated above, truck loading has a non-

linear relationship with pavement life-performance decrease. The more oil wells, the 

more overloading, the more rapid the decrease in pavement service life. However, Lee 
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county officials are aware of the high numbers of oil wells, but are not exactly aware of 

where are the routes that are going to be damaged. The model predicted these routes, 

and also provided estimates of how many additional ESALs these oil wells are going to 

add to the existing traffic loadings.  

Both analysis methods for Williamson County led to the prediction of extremely 

heavy locations with loadings up to 750,000 ESALs. These heavy loadings were 

generated in production traffic for building a “Braun Commercial” warehouse. The 

warehouse lot size is 2,836,211 square feet. This warehouse will add 750,000 ESALs 

every year to the pavement associated with linking it to the nearest heavy duty 

highway, , this loading route was successfully captured in this model which proves that 

with the implementation of an Easy-to-use, cost-effective tool not only Williamson 

county or Austin District can benefit from, every state, city and county officials can use 

this system. However, these numbers can vary depending on the assumptions made, 

but the concept of the two models remains valid for capturing unusual extremely high 

truck traffic loading.  
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CHAPTER 6: Conclusions 

 

The Early Warning System model was developed based on current research gaps 

of predicting land use changes truck impacts on pavement. Various studies generated 

tools and methods to save money on pavement. Little interest was shown on 

implementing GIS software to identify locations on where most damages are occurring. 

By following land use changes, it was found that most land use changes generate truck 

traffic associated with their activities of construction and production. This truck traffic 

can be heavy and unexpected for when first designing the pavement. One of the 

previous research gaps is linking the GIS source with Truck Trip Generation to forecast 

locations of heavy loadings. By using ArcGIS, linking GIS data by their type to the nearest 

predicted truck destination or origin can be made by finding the shortest path routes, 

that trucks are most likely to follow.  

On this concept, two case studies were built: 

1- Oil and Gas Growth case: Austin District model was an example of a model 

where GIS data for both the origins and destinations for the trucks were known, 

The Oil and Gas Model was built for the Austin TxDOT district area for two 

periods of analysis, June-August and September-December of 2014. The model 

used oil well permits data to forecast routes between oil wells and 

origins/destinations of facilities servicing the construction of an oil well. 

Production traffic was neglected on this case because of the low traffic 

compared to construction, and the heavy construction traffic will happen before 
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productions nonetheless. In this model results: Lee county had a segment of 

additional 120,000 ESALs on the pavement, this additional ESALs were definitely 

not accounted for when designing the pavement, as this segment is not in an 

industrial area or near an urban city where it is expected to have high-level 

loadings, the segment is in a rural area where most of the streets are designed 

based on the expectation of medium to low loadings.  

2- Urban Growth case: Williamson county model was an example where only 

origins or only destinations were known. The case study period was determined 

to be a year, from July 2014 to July 2015. This was assumed based on the fact 

that building development need on average a year to complete, in terms of 

construction traffic. The model had two output maps, one for production traffic 

and the other for construction truck traffic. In this case, land developments 

TTGTs were based on 1000 square foot area size. So for each 1000 square foot 

there is a certain truck rate associated with it. The solution for the absence of 

origins or destinations GIS data, or predictions, was solved based on connecting 

land development to the nearest state highway to forecast truck trips routes. 

This was based on the assumption that state highways are usually designed and 

maintained to hold high level of loadings compared to local streets or county 

level highways.  

Future research can be done in order to optimize the model. In general, less 

assumptions lead to a better model. in this thesis, the mystery of where the trucks are 

travelling was solved based on GIS software and estimation of origins and destinations. 
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however, in the urban growth model, a need for further research is clear based on the 

assumption that trucks will travel to and from the nearest highway. The assumption 

could be valid for calculation purposes, but in reality, this might not be ideal. More data 

lead to better models as well, the more the data is collected about locations and 

destinations of truck travel, the easier this model will be to implement. Collecting data is 

not the only way of getting GIS data, there could be other assumptions that are valid but 

were not accounted for or missed in the development this thesis. It would be ideal to 

further investigate this basic model that has a very strong base. The model predicted 

truck travel in relation to two land use changes, namely Oil and Gas and Urban growth, 

whereas the goal is for the model to work with any land use changes other than the 

two, as long as there is GIS-base geographic data or location information, and TTGTs, 

the model should be able to predict routes and loadings of trucks.  
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Appendix 

From TRRC Website: 

Oil Wells Excel Data:  
 

A- First Period ( June to August ) 
 
 (Operator Name, Lease Name, District Well Name, Total Depth and Amend columns 

were excluded from the files) 

ID X Y API NO. County 
Filing 

Purpose 

1 
-97.08662900 30.09179300 

2131634 BASTROP New Drill 

2 
-97.26206900 30.21971000 

2131635 BASTROP New Drill 

3 
-97.38373400 30.02018600 

2131636 BASTROP New Drill 

4 
-97.761806 29.770419 

5532943 CALDWELL Reenter 

5 
-97.630968 29.711973 

5535061 CALDWELL New Drill 

6 
-97.68657 29.860694 

5533307 CALDWELL Reenter 

7 
-97.69953 29.843777 

5533207 CALDWELL Reenter 

8 
-97.713864 29.826467 

5533444 CALDWELL Reenter 

9 
-97.503944 29.928296 

5535075 CALDWELL New Drill 

10 
-97.520155 29.930807 

5535081 CALDWELL New Drill 

11 
-97.6351 29.79616 

5535077 CALDWELL New Drill 

12 
-97.64104 29.796849 

5535078 CALDWELL New Drill 

13 
-97.635512 29.805114 

5535079 CALDWELL New Drill 

14 
-97.596832 29.84088 

5535080 CALDWELL New Drill 
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15 
-97.600229 29.761458 

5535025 CALDWELL Recompletion 

16 
-97.596677 29.840638 

5535082 CALDWELL New Drill 

17 
-97.518275 29.948145 

5535084 CALDWELL New Drill 

18 
-97.629919 29.81039 

5535083 CALDWELL New Drill 

19 
-97.60719 29.839367 

5535086 CALDWELL New Drill 

20 
-97.624821 29.820149 

5535087 CALDWELL New Drill 

21 
-97.744907 29.788336 

5532791 CALDWELL Reenter 

22 
-97.742139 29.79072 

5532649 CALDWELL Reenter 

23 
-96.825001 30.214699 

28732637 LEE New Drill 

24 
-96.740548 30.231031 

28732645 LEE New Drill 

25 
-96.993072 30.272004 

28732646 LEE New Drill 

26 
-96.994113 30.270966 

28732647 LEE New Drill 

27 
-96.936861 30.317956 

28732650 LEE New Drill 

28 
-96.937913 30.316956 

28732651 LEE New Drill 

29 
-96.938985 30.315881 

28732652 LEE New Drill 

30 
-96.90255 30.313603 

28732654 LEE New Drill 

31 
-96.874291 30.289352 

28732653 LEE New Drill 

32 
-96.892594 30.348273 

28732655 LEE New Drill 

33 
-96.839988 30.162136 

28732600 LEE Recompletion 

34 
-96.995406 30.269718 

28732656 LEE New Drill 

35 
-96.932685 30.347782 

28732657 LEE New Drill 

36 
-96.934402 30.347245 

28732658 LEE New Drill 

37 
-96.934767 30.345541 

28732659 LEE New Drill 
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38 
-96.951858 30.290004 

28732603 LEE Field Transfer 

39 
-96.918564 30.322333 

28732660 LEE New Drill 

40 
-96.917459 30.323361 

28732661 LEE New Drill 

41 
-96.981255 30.078648 

28732227 LEE Recompletion 

42 
-96.847617 30.31357 

28732662 LEE New Drill 

43 
-97.034084 30.107071 

28732287 LEE Recompletion 

44 
-96.962351 30.261968 

28732664 LEE New Drill 

45 
-96.954283 30.337982 

28732667 LEE New Drill 

46 
-96.955356 30.336889 

28732668 LEE New Drill 

47 
-96.956386 30.335889 

28732669 LEE New Drill 

48 
-96.969604 30.269103 

28732663 LEE New Drill 

49 
-97.061507 30.273884 

28732670 LEE New Drill 

50 
-96.959369 30.279276 

28732636 LEE New Drill 

51 
-96.972136 30.311922 

28732671 LEE New Drill 

52 
-96.973166 30.310921 

28732672 LEE New Drill 

53 
-96.97426 30.309902 

28732673 LEE New Drill 

54 
-96.997778 30.284854 

28732674 LEE New Drill 

55 
-97.004194 30.268102 

28732675 LEE New Drill 

56 
-97.005224 30.267046 

28732676 LEE New Drill 

57 
-96.962737 30.075138 

28732679 LEE New Drill 

58 
-96.999752 30.267027 

28732677 LEE New Drill 

59 
-96.41917 30.534547 

5133795 BURLESON New Drill 

60 
-96.662738 30.545861 

5133796 BURLESON New Drill 
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61 
-96.669405 30.546627 

5133797 BURLESON New Drill 

62 
-96.675476 30.606962 

5133798 BURLESON New Drill 

63 
-96.622 30.438866 

5133799 BURLESON New Drill 

64 
-96.464067 30.536408 

5133800 BURLESON New Drill 

65 
-96.781317 30.614331 

5133718 BURLESON New Drill 

66 
-96.688283 30.402277 

5130868 BURLESON Recompletion 

67 
-96.579336 30.380517 

5133804 BURLESON New Drill 

68 
-96.561109 30.400394 

5133802 BURLESON New Drill 

69 
-96.618086 30.719042 

5133801 BURLESON New Drill 

70 
-96.869156 30.529603 

5130418 BURLESON Reenter 

71 
-96.589476 30.551608 

5133803 BURLESON New Drill 

72 
-96.664698 30.494585 

5133783 BURLESON New Drill 

73 
-96.868082 30.497586 

5133773 BURLESON New Drill 

74 
-96.816491 30.547423 

5133805 BURLESON New Drill 

75 
-96.521059 30.499948 

5133806 BURLESON New Drill 

76 
-96.519954 30.500936 

5133807 BURLESON New Drill 

77 
-96.518848 30.501924 

5133808 BURLESON New Drill 

78 
-96.88453 30.495818 

5133761 BURLESON New Drill 

79 
-96.731157 30.460332 

5133809 BURLESON New Drill 

80 
-96.363428 30.541814 

5133810 BURLESON New Drill 

81 
-96.375128 30.5439 

5133811 BURLESON New Drill 

82 
-96.679564 30.534017 

5133812 BURLESON New Drill 

83 
-96.510022 30.494906 

5133781 BURLESON New Drill 
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84 
-96.511138 30.493928 

5133815 BURLESON New Drill 

85 
-96.715813 30.440465 

5133813 BURLESON New Drill 

86 
-96.744079 30.465628 

5133814 BURLESON New Drill 

87 
-96.753244 30.590118 

5133820 BURLESON New Drill 

88 
-96.407995 30.48661 

5133817 BURLESON New Drill 

89 
-96.434101 30.49487 

5133818 BURLESON New Drill 

90 
-96.410284 30.484723 

5133819 BURLESON New Drill 

91 
-96.652158 30.393408 

5133821 BURLESON New Drill 

92 
-96.436361 30.492937 

5133816 BURLESON New Drill 

93 
-96.366332 30.519468 

5133825 BURLESON New Drill 

94 
-96.658603 30.347383 

5133822 BURLESON New Drill 

95 
-96.356151 30.522147 

5133828 BURLESON New Drill 

96 
-96.357114 30.520617 

5133829 BURLESON New Drill 

97 
-96.604263 30.713474 

5133823 BURLESON New Drill 

98 
-96.465295 30.526039 

5133826 BURLESON New Drill 

99 
-96.358947 30.519982 

5133830 BURLESON New Drill 

100 
-96.430674 30.45155 

5133831 BURLESON New Drill 

101 
-96.58449 30.683917 

5133827 BURLESON New Drill 

102 
-96.653648 30.573632 

5133835 BURLESON New Drill 

103 
-96.519511 30.454457 

5133832 BURLESON New Drill 

104 
-96.517865 30.455913 

5133833 BURLESON New Drill 

105 
-96.516219 30.457368 

5133834 BURLESON New Drill 

106 
-96.909483 29.736361 

14933358 FAYETTE New Drill 
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107 
-97.163851 29.725281 

14933359 FAYETTE New Drill 

108 
-97.161545 29.722699 

14933360 FAYETTE New Drill 

109 
-97.080724 29.799426 

14933363 FAYETTE New Drill 

110 
-97.113425 29.62889 

14933362 FAYETTE New Drill 

111 
-97.168633 29.703293 

14933352 FAYETTE New Drill 

112 
-97.191771 29.708908 

14932140 FAYETTE Recompletion 

113 
-97.130746 29.675837 

14933367 FAYETTE New Drill 

114 
-97.130621 29.674289 

14933368 FAYETTE New Drill 

115 
-97.130842 29.672967 

14933371 FAYETTE New Drill 

116 
-97.148156 29.657569 

14933372 FAYETTE New Drill 

117 
-97.146576 29.656373 

14933373 FAYETTE New Drill 

118 
-97.09071 29.611556 

14933365 FAYETTE New Drill 

119 
-97.088794 29.611472 

14933366 FAYETTE New Drill 

120 
-97.162724 29.683001 

14933354 FAYETTE New Drill 

121 
-97.211558 29.7935 

14933369 FAYETTE New Drill 

122 
-97.133239 29.816304 

14933264 FAYETTE New Drill 

123 
-97.273961 29.773311 

14933370 FAYETTE New Drill 

124 
-97.003712 29.692988 

14933374 FAYETTE New Drill 

125 
-97.066759 29.820729 

14933334 FAYETTE New Drill 

126 
-97.097391 29.629457 

14933307 FAYETTE New Drill 

127 
-97.095664 29.629215 

14933375 FAYETTE New Drill 

128 
-97.119335 29.666449 

14933328 FAYETTE New Drill 

129 
-97.09393 29.629249 

14933376 FAYETTE New Drill 
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130 
-97.0922 29.629285 

14933377 FAYETTE New Drill 

131 
-97.162724 29.683001 

14933354 FAYETTE New Drill 

132 
-97.086066 29.629999 

14933353 FAYETTE New Drill 

133 
-96.746964 29.895771 

14933378 FAYETTE New Drill 

134 
-97.312847 29.405455 

17733356 GONZALES New Drill 

135 
-97.698465 29.210873 

17733371 GONZALES New Drill 

136 
-97.34354 29.59227 

17733277 GONZALES New Drill 

137 
-97.205558 29.676783 

17733373 GONZALES New Drill 

138 
-97.307109 29.403304 

17733358 GONZALES New Drill 

139 
-97.37056 29.406497 

17733376 GONZALES New Drill 

140 
-97.373271 29.404861 

17733378 GONZALES New Drill 

141 
-97.422829 29.557362 

17733382 GONZALES New Drill 

142 
-97.651232 29.342182 

17733372 GONZALES New Drill 

143 
-97.371441 29.405963 

17733375 GONZALES New Drill 

144 
-97.701134 29.37955 

17733288 GONZALES New Drill 

145 
-97.63192 29.32688 

17733354 GONZALES New Drill 

146 
-97.630612 29.330107 

17733355 GONZALES New Drill 

147 
-97.372468 29.405541 

17733377 GONZALES New Drill 

148 
-97.234817 29.537508 

17733389 GONZALES New Drill 

149 
-97.638651 29.375417 

17733383 GONZALES New Drill 

150 
-97.468566 29.246863 

17733352 GONZALES New Drill 

151 
-97.567801 29.181009 

17733385 GONZALES New Drill 

152 
-97.567416 29.181608 

17733386 GONZALES New Drill 
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153 
-97.566759 29.18196 

17733387 GONZALES New Drill 

154 
-97.615309 29.352049 

17733384 GONZALES New Drill 

155 
-97.658761 29.285695 

17733381 GONZALES New Drill 

156 
-97.220479 29.532277 

17733388 GONZALES New Drill 

157 
-97.330335 29.629744 

17733398 GONZALES New Drill 

158 
-97.234158 29.565854 

17733390 GONZALES New Drill 

159 
-97.58234 29.211646 

17733392 GONZALES New Drill 

160 
-97.581898 29.212387 

17733393 GONZALES New Drill 

161 
-97.581481 29.213114 

17733395 GONZALES New Drill 

162 
-97.516864 29.251732 

17733394 GONZALES New Drill 

163 
-97.516389 29.252432 

17733396 GONZALES New Drill 

164 
-97.515947 29.253212 

17733397 GONZALES New Drill 

165 
-97.204732 29.61815 

17733400 GONZALES New Drill 

166 
-97.204661 29.616728 

17733399 GONZALES New Drill 

167 
-97.364383 29.443821 

17732791 GONZALES Recompletion 

168 
-97.390519 29.258283 

17732686 GONZALES Field Transfer 

169 
-97.387894 29.258414 

17732684 GONZALES Field Transfer 

170 
-97.670613 29.25379 

17733404 GONZALES New Drill 

171 
-97.160269 29.605171 

17733401 GONZALES New Drill 

172 
-97.159135 29.605784 

17733402 GONZALES New Drill 

173 
-97.158362 29.606658 

17733403 GONZALES New Drill 

174 
-97.389767 29.258872 

17732683 GONZALES Field Transfer 

175 
-97.391942 29.258474 

17732682 GONZALES Field Transfer 
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176 
-97.432652 29.302562 

17733406 GONZALES New Drill 

177 
-97.430093 29.303078 

17733407 GONZALES New Drill 

178 
-97.422874 29.311158 

17733410 GONZALES New Drill 

179 
-97.686382 29.306103 

17733391 GONZALES New Drill 

180 
-97.262716 29.387668 

17733421 GONZALES New Drill 

181 
-97.303776 29.403922 

17733415 GONZALES New Drill 

182 
-97.302146 29.404369 

17733416 GONZALES New Drill 

183 
-97.300543 29.404808 

17733417 GONZALES New Drill 

184 
-97.504146 29.339585 

17731914 GONZALES Recompletion 

185 
-97.534903 29.192578 

17733419 GONZALES New Drill 

186 
-97.535819 29.192142 

17733420 GONZALES New Drill 

187 
-97.427418 29.303728 

17733408 GONZALES New Drill 

188 
-97.520094 29.249568 

17733418 GONZALES New Drill 

189 
-97.263589 29.387161 

17733422 GONZALES New Drill 

190 
-97.264631 29.386947 

17733423 GONZALES New Drill 

191 
-97.265717 29.386197 

17733424 GONZALES New Drill 

192 
-97.421749 29.31305 

17733409 GONZALES New Drill 

193 
-97.580951 29.213819 

17733425 GONZALES New Drill 

194 
-97.580455 29.214513 

17733426 GONZALES New Drill 

195 
-97.580041 29.215248 

17733427 GONZALES New Drill 

196 
-97.612318 29.354328 

17733443 GONZALES New Drill 

197 
-97.305553 29.403736 

17733414 GONZALES New Drill 

198 
-97.317475 29.341779 

17733430 GONZALES New Drill 
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199 
-97.316791 29.342199 

17733431 GONZALES New Drill 

200 
-97.413955 29.373581 

17733319 GONZALES New Drill 

201 
-97.409763 29.373126 

17733448 GONZALES New Drill 

202 
-97.408822 29.37517 

17733449 GONZALES New Drill 

203 
-97.683962 29.30837 

17733380 GONZALES New Drill 

204 
-97.299315 29.326131 

17733436 GONZALES New Drill 

205 
-97.300114 29.325689 

17733437 GONZALES New Drill 

206 
-97.300868 29.325208 

17733438 GONZALES New Drill 

207 
-97.226889 29.571817 

17733441 GONZALES New Drill 

208 
-97.204068 29.557387 

17733439 GONZALES New Drill 

209 
-97.530417 29.215544 

17733440 GONZALES New Drill 

210 
-97.318842 29.340621 

17733429 GONZALES New Drill 

211 
-97.356209 29.296518 

17733446 GONZALES New Drill 

212 
-97.651232 29.342182 

17733372 GONZALES New Drill 

213 
-97.657535 29.288521 

17733434 GONZALES New Drill 

214 
-97.399277 29.383058 

17733450 GONZALES New Drill 

215 
-97.400152 29.382436 

17733451 GONZALES New Drill 

216 
-97.400952 29.381886 

17733454 GONZALES New Drill 

217 
-97.353982 29.412013 

17733452 GONZALES New Drill 

218 
-97.353085 29.412477 

17733453 GONZALES New Drill 

219 
-97.352215 29.412833 

17733455 GONZALES New Drill 

220 
-97.528424 29.199034 

17733432 GONZALES New Drill 

221 
-97.528895 29.19801 

17733433 GONZALES New Drill 
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222 
-97.356775 29.299378 

17733442 GONZALES New Drill 

223 
-97.39181 29.367645 

17733444 GONZALES New Drill 

224 
-97.392378 29.366942 

17733445 GONZALES New Drill 

225 
-97.355542 29.296937 

17733447 GONZALES New Drill 

226 
-97.466496 29.274303 

17733156 GONZALES New Drill 

227 
-97.46736 29.274009 

17733161 GONZALES New Drill 

228 
-97.456182 29.251099 

17733160 GONZALES New Drill 

229 
-97.457149 29.250774 

17733162 GONZALES New Drill 

230 
-97.465633 29.274598 

17733459 GONZALES New Drill 

231 
-97.512195 29.209439 

17733462 GONZALES New Drill 

232 
-97.237235 29.453731 

17733458 GONZALES New Drill 

233 
-97.144532 29.606771 

17733465 GONZALES New Drill 

234 
-97.144431 29.608087 

17733466 GONZALES New Drill 

235 
-97.743209 29.608455 

18733630 GUADALUPE New Drill 

236 
-98.043043 29.419234 

18733631 GUADALUPE New Drill 

237 
-97.707638 29.655179 

18733632 GUADALUPE New Drill 

238 
-98.101658 29.416845 

18733633 GUADALUPE New Drill 

239 
-98.038994 29.395743 

18733635 GUADALUPE New Drill 

240 
-98.038994 29.395743 

18733636 GUADALUPE New Drill 

241 
-96.989629 30.623836 

33134884 MILAM New Drill 

242 
-96.99613 30.617336 

33134882 MILAM New Drill 

243 
-96.99753 30.623236 

33134883 MILAM New Drill 

244 
-96.940453 30.793792 

33134891 MILAM New Drill 
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245 
-96.939654 30.793341 

33134892 MILAM New Drill 

246 
-96.991652 30.632533 

33134885 MILAM New Drill 

247 
-96.991391 30.631794 

33134887 MILAM New Drill 

248 
-96.991118 30.631147 

33134890 MILAM New Drill 

249 
-96.991877 30.633085 

33134889 MILAM New Drill 

250 
-96.962545 30.659087 

33134896 MILAM New Drill 

251 
-96.992427 30.632719 

33134888 MILAM New Drill 

252 
-96.992202 30.632044 

33134886 MILAM New Drill 

253 
-96.917463 30.605552 

33134895 MILAM New Drill 

254 
-96.901081 30.632008 

33134897 MILAM New Drill 

255 
-97.058168 30.710578 

33134898 MILAM New Drill 

256 
-97.036558 30.958374 

33134899 MILAM New Drill 

257 
-97.050618 30.705965 

33134904 MILAM New Drill 

258 
-97.053632 30.710056 

33134905 MILAM New Drill 

259 
-97.054363 30.709916 

33134906 MILAM New Drill 

260 
-96.776666 30.681111 

33134879 MILAM New Drill 

261 
-97.012116 30.679797 

33134915 MILAM New Drill 

262 
-96.939302 30.79412 

33134902 MILAM New Drill 

263 
-96.938698 30.795833 

33134903 MILAM New Drill 

264 
-96.938004 30.798468 

33134913 MILAM New Drill 

265 
-96.93933 30.799573 

33134914 MILAM New Drill 

266 
-96.715055 30.209004 

47731021 WASHINGTON New Drill 

 



 
94 

 

B- Second Period ( September to November)  
 

ID X Y API NO. County 
Filing 

Purpose 

1 -97.3714070 30.0239530 2131637 BASTROP New Drill 

2 -97.2685180 30.2186310 2131638 BASTROP New Drill 

3 -97.1041910 30.0318530 2131639 BASTROP New Drill 

4 -97.0859800 30.1001160 2131640 BASTROP New Drill 

5 -97.1383490 30.1865240 2131572 BASTROP Recompletion 

6 -97.7253510 29.8184860 5535088 CALDWELL New Drill 

7 -97.7569580 29.7784520 5533872 CALDWELL Reenter 

8 -97.6111320 29.8241460 5535089 CALDWELL New Drill 

9 -97.6909970 29.7711510 5534808 CALDWELL Recompletion 

10 -97.6760410 29.7700900 5535090 CALDWELL New Drill 

11 -97.5876570 29.8425920 5505300 CALDWELL Recompletion 

12 -97.6760630 29.7700900 5535090 CALDWELL New Drill 

13 -97.5077270 29.9305150 5535091 CALDWELL New Drill 

14 -97.6712990 29.7725670 5535092 CALDWELL New Drill 

15 -97.5156240 29.9244530 5535094 CALDWELL New Drill 

16 -96.9327050 30.3477630 28732657 LEE New Drill 

17 -96.9343780 30.3472070 28732658 LEE New Drill 

18 -97.0105530 30.3331140 28732680 LEE New Drill 

19 -97.0013480 30.2776310 28732678 LEE New Drill 

20 -96.8664000 30.2708670 28732681 LEE New Drill 



 
95 

 

21 -96.9805340 30.2760930 28732691 LEE New Drill 

22 -96.9817140 30.2750730 28732682 LEE New Drill 

23 -96.9827220 30.2740910 28732683 LEE New Drill 

24 -96.9837520 30.2730530 28732688 LEE New Drill 

25 -96.9848470 30.2720340 28732689 LEE New Drill 

26 -96.9856190 30.2709220 28732687 LEE New Drill 

27 -96.9869500 30.2699770 28732690 LEE New Drill 

28 -96.9736460 30.3074790 28732684 LEE New Drill 

29 -96.9747830 30.3065160 28732685 LEE New Drill 

30 -96.9751480 30.3049410 28732686 LEE New Drill 

31 -96.8574740 30.2634540 28732692 LEE New Drill 

32 -96.8607570 30.2604880 28732693 LEE New Drill 

33 -96.8590830 30.2619710 28732694 LEE New Drill 

34 -96.7958910 30.3331880 28730364 LEE Recompletion 

35 -96.9759420 30.1617830 28732445 LEE Reclass 

36 -96.9275330 30.0750670 28732695 LEE New Drill 

37 -96.9986660 30.2106380 28732639 LEE New Drill 

38 -96.9976140 30.2116020 28732638 LEE New Drill 

39 -96.8830520 30.3373180 28732696 LEE New Drill 

40 -96.8842320 30.3363370 28732697 LEE New Drill 

41 -96.8854120 30.3354480 28732698 LEE New Drill 

42 -96.9041440 30.2947330 28732700 LEE New Drill 

43 -96.9027070 30.2954560 28732699 LEE New Drill 
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44 -96.9013120 30.2961780 28732703 LEE New Drill 

45 -96.8812710 30.1203650 28732534 LEE Recompletion 

46 -96.9827440 30.2915460 28732701 LEE New Drill 

47 -96.9837950 30.2905090 28732702 LEE New Drill 

48 -96.9041230 30.2947330 28732700 LEE New Drill 

49 -96.9041230 30.2947330 28732699 LEE New Drill 

50 -96.8650920 30.2368180 28730581 LEE Recompletion 

51 -96.8899820 30.4355330 28732704 LEE New Drill 

52 -96.8812490 30.1203650 28732534 LEE Recompletion 

53 -96.9847610 30.2894340 28732705 LEE New Drill 

54 -96.5611010 30.4002640 05133802 BURLESON New Drill 

55 -96.4673520 30.5334080 05133824 BURLESON New Drill 

56 -96.4332560 30.5185850 05133836 BURLESON New Drill 

57 -96.4312600 30.5202850 05133837 BURLESON New Drill 

58 -96.6276410 30.3766090 05133838 BURLESON New Drill 

59 -96.5855410 30.6817620 05133839 BURLESON New Drill 

60 -96.5873220 30.6808580 05133840 BURLESON New Drill 

61 -96.3806630 30.5351640 05133841 BURLESON New Drill 

62 -96.3672950 30.5189170 05133842 BURLESON New Drill 

63 -96.3706850 30.5177900 05133843 BURLESON New Drill 

64 -96.6601920 30.5257940 05133845 BURLESON New Drill 

65 -96.6576820 30.6182970 05133844 BURLESON New Drill 

66 -96.5530110 30.4837340 05133846 BURLESON New Drill 
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67 -96.7684250 30.5151090 05133847 BURLESON New Drill 

68 -96.6524460 30.3934900 05133849 BURLESON New Drill 

69 -96.4900760 30.4811820 05133850 BURLESON New Drill 

70 -96.4890670 30.4822550 05133851 BURLESON New Drill 

71 -96.4879730 30.4832350 05133853 BURLESON New Drill 

72 -96.4868360 30.4842700 05133852 BURLESON New Drill 

73 -96.4713860 30.4335720 05133855 BURLESON New Drill 

74 -96.4695410 30.4352000 05133856 BURLESON New Drill 

75 -96.4676310 30.4369020 05133857 BURLESON New Drill 

76 -96.5067480 30.4648520 05133854 BURLESON New Drill 

77 -96.5049240 30.4664980 05133860 BURLESON New Drill 

78 -96.5029720 30.4681810 05133861 BURLESON New Drill 

79 -96.4657640 30.4385860 05133858 BURLESON New Drill 

80 -96.4579750 30.3928980 05133859 BURLESON New Drill 

81 -96.4361960 30.4938490 05133862 BURLESON New Drill 

82 -96.7721150 30.5144250 05133863 BURLESON New Drill 

83 -96.7736170 30.5119300 05133864 BURLESON New Drill 

84 -96.4379570 30.4922540 05133866 BURLESON New Drill 

85 -96.3627690 30.5195050 05133868 BURLESON New Drill 

86 -96.6334360 30.4022220 05133870 BURLESON New Drill 

87 -96.6651290 30.4075150 05133865 BURLESON New Drill 

88 -96.6204110 30.4913480 05133867 BURLESON New Drill 

89 -96.5864440 30.4015000 05133871 BURLESON New Drill 
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90 -96.5606730 30.6078590 05133869 BURLESON New Drill 

91 -96.5572400 30.6093180 05133883 BURLESON New Drill 

92 -96.6521470 30.3933010 05133821 BURLESON New Drill 

93 -96.7618170 30.5912180 05133768 BURLESON New Drill 

94 -96.6524480 30.3854900 05133874 BURLESON New Drill 

95 -96.6480920 30.3893400 05133878 BURLESON New Drill 

96 -96.5884180 30.3995010 05133877 BURLESON New Drill 

97 -96.5907570 30.3973910 05133879 BURLESON New Drill 

98 -96.6380070 30.3977980 05133873 BURLESON New Drill 

99 -96.6355390 30.3999080 05133875 BURLESON New Drill 

100 -96.8411040 30.5116850 05133876 BURLESON New Drill 

101 -96.6772740 30.6462470 05133881 BURLESON New Drill 

102 -96.7133450 30.4888710 05133880 BURLESON New Drill 

103 -96.6316340 30.5654840 05133794 BURLESON New Drill 

104 -96.4655300 30.4662720 05133884 BURLESON New Drill 

105 -96.5279070 30.6050330 05133281 BURLESON Recompletion 

106 -96.5545360 30.6113860 05133882 BURLESON New Drill 

107 -96.4353820 30.5175450 05133885 BURLESON New Drill 

108 -96.3287370 30.4564330 05133886 BURLESON New Drill 

109 -96.7721600 30.5144210 05133863 BURLESON New Drill 

110 -96.7736170 30.5119300 05133864 BURLESON New Drill 

111 -96.7684250 30.5151090 05133847 BURLESON New Drill 

112 -96.8845340 30.4956930 05133761 BURLESON Recompletion 
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113 -96.3806630 30.5351640 05133841 BURLESON New Drill 

114 -96.6462460 30.3455740 05133889 BURLESON New Drill 

115 -96.6444010 30.3473140 05133890 BURLESON New Drill 

116 -96.6425770 30.3488700 05133891 BURLESON New Drill 

117 -96.5793410 30.3803990 05133804 BURLESON New Drill 

118 -96.6407100 30.3505550 05133892 BURLESON New Drill 

119 -96.6389080 30.3522210 05133893 BURLESON New Drill 

120 -96.6452810 30.4897950 05133787 BURLESON New Drill 

121 -96.3806630 30.5351640 05133841 BURLESON New Drill 

122 -96.4268420 30.5297820 05130311 BURLESON Recompletion 

123 -96.4324420 30.5534740 05133746 BURLESON New Drill 

124 -96.5793410 30.3803990 05133804 BURLESON New Drill 

125 -96.3608810 30.5194120 05133894 BURLESON New Drill 

126 -96.3650010 30.5188950 05133896 BURLESON New Drill 

127 -96.6978310 30.4881860 05133897 BURLESON New Drill 

128 -96.4900760 30.4811820 05133850 BURLESON New Drill 

129 -96.4890670 30.4822550 05133851 BURLESON New Drill 

130 -96.4879730 30.4832350 05133853 BURLESON New Drill 

131 -96.4868360 30.4842700 05133852 BURLESON New Drill 

132 -96.6810720 30.5205580 05133779 BURLESON New Drill 

133 -96.6425770 30.3488700 05133891 BURLESON New Drill 

134 -96.4817730 30.4887410 05133898 BURLESON New Drill 

135 -96.4829110 30.4877980 05133899 BURLESON New Drill 
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136 -96.4850780 30.4858200 05133901 BURLESON New Drill 

137 -96.3690780 30.5185070 05133902 BURLESON New Drill 

138 -96.3707300 30.5177670 05133843 BURLESON New Drill 

139 -96.3717170 30.5167320 05133903 BURLESON New Drill 

140 -96.5195170 30.4543050 05133832 BURLESON New Drill 

141 -96.5162770 30.4572460 05133834 BURLESON New Drill 

142 -97.1542570 29.8452500 14933294 FAYETTE New Drill 

143 -97.1229500 29.7729720 14933382 FAYETTE New Drill 

144 -97.1483340 29.7568980 14933379 FAYETTE New Drill 

145 -97.1576040 29.7469500 14933380 FAYETTE New Drill 

146 -97.1145820 29.7792300 14933381 FAYETTE New Drill 

147 -97.1588920 29.6670880 14933383 FAYETTE New Drill 

148 -97.1588700 29.6662300 14933384 FAYETTE New Drill 

149 -97.1553730 29.6643100 14933385 FAYETTE New Drill 

150 -97.1553080 29.6622770 14933386 FAYETTE New Drill 

151 -97.1552650 29.6602080 14933387 FAYETTE New Drill 

152 -97.1505450 29.6583620 14933388 FAYETTE New Drill 

153 -97.1519820 29.6581750 14933389 FAYETTE New Drill 

154 -97.1537420 29.6579700 14933390 FAYETTE New Drill 

155 -97.1552870 29.6576340 14933391 FAYETTE New Drill 

156 -97.1568530 29.6574670 14933392 FAYETTE New Drill 

157 -97.1184650 29.7766420 14932698 FAYETTE Recompletion 

158 -97.1481410 29.6574480 14933372 FAYETTE New Drill 
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159 -97.1465750 29.6562920 14933373 FAYETTE New Drill 

160 -97.1929020 29.7084340 14933393 FAYETTE New Drill 

161 -96.9094890 29.7362740 14933358 FAYETTE New Drill 

162 -97.0303600 29.6630980 14933394 FAYETTE New Drill 

163 -97.0866220 30.0116300 14933395 FAYETTE New Drill 

164 -97.1318550 29.6711710 14933396 FAYETTE New Drill 

165 -97.1334430 29.6714130 14933398 FAYETTE New Drill 

166 -97.1350090 29.6716740 14933397 FAYETTE New Drill 

167 -97.0850560 29.8276970 14933293 FAYETTE New Drill 

168 -97.1278420 29.8434260 14933275 FAYETTE New Drill 

169 -97.1714870 29.6757390 14933399 FAYETTE New Drill 

170 -96.7457030 29.9117460 14933400 FAYETTE New Drill 

171 -97.0841330 29.6292880 14933401 FAYETTE New Drill 

172 -96.8836760 30.0689720 14933210 FAYETTE Recompletion 

173 -97.1201180 29.8071070 14933297 FAYETTE New Drill 

174 -97.0578900 30.0300050 14933402 FAYETTE New Drill 

175 -97.1107410 29.6904470 14933403 FAYETTE New Drill 

176 -97.1084320 29.6902240 14933405 FAYETTE New Drill 

177 -97.1063930 29.6902990 14933404 FAYETTE New Drill 

178 -97.3941840 29.2575270 17732681 GONZALES Field Transfer 

179 -97.3404110 29.5309450 17731049 GONZALES Recompletion 

180 -97.2271140 29.5705550 17733098 GONZALES New Drill 

181 -97.5416840 29.3508420 17733015 GONZALES Recompletion 
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182 -97.5135530 29.2085800 17733460 GONZALES New Drill 

183 -97.5141100 29.2083360 17733461 GONZALES New Drill 

184 -97.5155270 29.2077000 17733463 GONZALES New Drill 

185 -97.5147330 29.2079430 17733464 GONZALES New Drill 

186 -97.2288090 29.7058250 17733467 GONZALES New Drill 

187 -97.2545800 29.3817540 17733468 GONZALES New Drill 

188 -97.2573480 29.4122270 17733469 GONZALES New Drill 

189 -97.4552090 29.2512740 17733470 GONZALES New Drill 

190 -97.6301750 29.2203040 17731780 GONZALES Recompletion 

191 -97.2460610 29.7209950 17733472 GONZALES New Drill 

192 -97.2367700 29.6175180 17733473 GONZALES New Drill 

193 -97.2375000 29.6156710 17733474 GONZALES New Drill 

194 -97.4185590 29.2544940 17733475 GONZALES New Drill 

195 -97.4178730 29.2549060 17733476 GONZALES New Drill 

196 -97.4172080 29.2553930 17733477 GONZALES New Drill 

197 -97.5591930 29.3017160 17733488 GONZALES New Drill 

198 -97.5571330 29.1652310 17733479 GONZALES New Drill 

199 -97.6631130 29.2427370 17733484 GONZALES New Drill 

200 -97.5743850 29.1542690 17733480 GONZALES New Drill 

201 -97.5564250 29.2193110 17733481 GONZALES New Drill 

202 -97.5569610 29.2188240 17733482 GONZALES New Drill 

203 -97.5574760 29.2183370 17733483 GONZALES New Drill 

204 -97.2445160 29.4808220 17733485 GONZALES New Drill 
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205 -97.2428850 29.4825780 17733486 GONZALES New Drill 

206 -97.6421480 29.3227460 17733478 GONZALES New Drill 

207 -97.2673260 29.5913800 17733145 GONZALES New Drill 

208 -97.2630340 29.5955970 17733197 GONZALES New Drill 

209 -97.2716170 29.3907850 17733495 GONZALES New Drill 

210 -97.2411260 29.4797940 17733489 GONZALES New Drill 

211 -97.2391520 29.4814760 17733491 GONZALES New Drill 

212 -97.2426490 29.4481090 17733492 GONZALES New Drill 

213 -97.5875820 29.3734520 17732526 GONZALES Recompletion 

214 -97.2738490 29.3912900 17733493 GONZALES New Drill 

215 -97.2727550 29.3911400 17733494 GONZALES New Drill 

216 -97.4990470 29.2293860 17733503 GONZALES New Drill 

217 -97.4982960 29.2295920 17733504 GONZALES New Drill 

218 -97.4976740 29.2298170 17733505 GONZALES New Drill 

219 -97.4376780 29.2432230 17733490 GONZALES New Drill 

220 -97.4970300 29.2300230 17733506 GONZALES New Drill 

221 -97.5777110 29.1977730 17733497 GONZALES New Drill 

222 -97.5577770 29.1648190 17733496 GONZALES New Drill 

223 -97.2728620 29.3687960 17733234 GONZALES New Drill 

224 -97.2401170 29.4806160 17733194 GONZALES New Drill 

225 -97.5663600 29.1822430 17733501 GONZALES New Drill 

226 -97.4057490 29.2513860 17733270 GONZALES New Drill 

227 -97.4049550 29.2541940 17733269 GONZALES New Drill 
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228 -97.5713380 29.1907290 17733502 GONZALES New Drill 

229 -97.6225790 29.1457610 17733507 GONZALES New Drill 

230 -97.6236950 29.1449180 17733508 GONZALES New Drill 

231 -97.2449670 29.5832260 17733510 GONZALES New Drill 

232 -97.2432290 29.5832070 17733511 GONZALES New Drill 

233 -97.5712740 29.1916100 17733512 GONZALES New Drill 

234 -97.5708660 29.1922470 17733513 GONZALES New Drill 

235 -97.4520330 29.3188740 17733517 GONZALES New Drill 

236 -97.4528270 29.3171520 17733518 GONZALES New Drill 

237 -97.4536210 29.3161790 17733519 GONZALES New Drill 

238 -97.5040680 29.3229900 17733516 GONZALES New Drill 

239 -97.4505310 29.2256220 17733520 GONZALES New Drill 

240 -97.4515830 29.2260900 17733521 GONZALES New Drill 

241 -97.5933320 29.1916470 17733529 GONZALES New Drill 

242 -97.5926670 29.1923220 17733530 GONZALES New Drill 

243 -97.5921520 29.1930900 17733531 GONZALES New Drill 

244 -97.3396380 29.3141770 17733524 GONZALES New Drill 

245 -97.3377500 29.3147200 17733522 GONZALES New Drill 

246 -97.3386940 29.3144770 17733523 GONZALES New Drill 

247 -97.4524410 29.2563850 17733525 GONZALES New Drill 

248 -97.4530200 29.2557300 17733526 GONZALES New Drill 

249 -97.4537500 29.2553740 17733527 GONZALES New Drill 

250 -97.3552160 29.3719380 17733532 GONZALES New Drill 



 
105 

 

251 -97.3562890 29.3758640 17733535 GONZALES New Drill 

252 -97.4543720 29.2549430 17733528 GONZALES New Drill 

253 -97.6060570 29.2046470 17733539 GONZALES New Drill 

254 -97.2112140 29.4514540 17733538 GONZALES New Drill 

255 -97.2116650 29.4507440 17733537 GONZALES New Drill 

256 -97.2123510 29.4500900 17733536 GONZALES New Drill 

257 -97.3624910 29.3910090 17733533 GONZALES New Drill 

258 -97.3633920 29.3906540 17733534 GONZALES New Drill 

259 -97.5807580 29.4032920 17732965 GONZALES Recompletion 

260 -97.6040610 29.1490600 17733540 GONZALES New Drill 

261 -97.6048980 29.1485540 17733541 GONZALES New Drill 

262 -97.5847280 29.2077750 17733542 GONZALES New Drill 

263 -97.6236090 29.3927480 17732817 GONZALES New Drill 

264 -97.6236090 29.3927480 17733289 GONZALES New Drill 

265 -97.5842340 29.2084300 17733543 GONZALES New Drill 

266 -97.5837840 29.2092350 17733544 GONZALES New Drill 

267 -97.4354680 29.2660250 17733193 GONZALES New Drill 

268 -97.3608170 29.3841470 17733546 GONZALES New Drill 

269 -97.4364340 29.2649770 17733192 GONZALES New Drill 

270 -97.3635420 29.3912520 17733545 GONZALES New Drill 

271 -97.3054780 29.3510860 17733547 GONZALES New Drill 

272 -97.3048770 29.3515530 17733548 GONZALES New Drill 

273 -97.2898990 29.3410410 17733549 GONZALES New Drill 



 
106 

 

274 -97.2894270 29.3416030 17733550 GONZALES New Drill 

275 -97.4129590 29.2746920 17733271 GONZALES New Drill 

276 -97.6943980 29.2622820 17733300 GONZALES New Drill 

277 -97.2393020 29.4479030 17733555 GONZALES New Drill 

278 -97.2501170 29.3975340 17733551 GONZALES New Drill 

279 -98.0380640 29.3980390 18733650 GUADALUPE New Drill 

280 -98.0380000 29.3956270 18733634 GUADALUPE New Drill 

281 -98.0377850 29.4014970 18733649 GUADALUPE New Drill 

282 -98.0378060 29.4024130 18733638 GUADALUPE New Drill 

283 -98.0401880 29.4001880 18733651 GUADALUPE New Drill 

284 -98.0412180 29.4002070 18733639 GUADALUPE New Drill 

285 -98.0426340 29.4002260 18733640 GUADALUPE New Drill 

286 -98.0387290 29.4027310 18733641 GUADALUPE New Drill 

287 -98.0811940 29.4247310 18733637 GUADALUPE New Drill 

288 -97.7579770 29.6973070 18733389 GUADALUPE Recompletion 

289 -97.7432350 29.6083210 18733630 GUADALUPE Recompletion 

290 -98.0152970 29.4320200 18733642 GUADALUPE New Drill 

291 -97.7503170 29.5945150 18733494 GUADALUPE Recompletion 

292 -98.1108050 29.3894570 18733643 GUADALUPE New Drill 

293 -98.1105910 29.3886160 18733644 GUADALUPE New Drill 

294 -98.1096250 29.3887660 18733645 GUADALUPE New Drill 

295 -97.7726540 29.5717680 18733646 GUADALUPE New Drill 

296 -97.7265630 29.5676810 18733647 GUADALUPE New Drill 
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297 -97.8601370 29.3843530 18733648 GUADALUPE New Drill 

298 -98.0430850 29.3843910 18733653 GUADALUPE New Drill 

299 -98.0429560 29.3835490 18733652 GUADALUPE New Drill 

300 -97.0932180 30.7565610 33134900 MILAM New Drill 

301 -97.0378790 30.8097630 33134910 MILAM New Drill 

302 -97.0245540 30.8029990 33134901 MILAM New Drill 

303 -97.0030530 30.6348380 33134908 MILAM New Drill 

304 -96.9919170 30.6311080 33134912 MILAM New Drill 

305 -96.9929040 30.6322530 33134907 MILAM New Drill 

306 -97.0022160 30.6347460 33134911 MILAM New Drill 

307 -97.0040830 30.6344320 33134909 MILAM New Drill 

308 -96.9947280 30.6271750 33134916 MILAM New Drill 

309 -96.9952430 30.6276740 33134917 MILAM New Drill 

310 -96.9959510 30.6274160 33134918 MILAM New Drill 

311 -96.9058500 30.7466770 33134920 MILAM New Drill 

312 -96.9040260 30.7476540 33134919 MILAM New Drill 

313 -96.9972170 30.6267690 33134921 MILAM New Drill 

314 -96.9968730 30.6262340 33134922 MILAM New Drill 

315 -96.9977320 30.6259380 33134923 MILAM New Drill 

316 -96.9957360 30.6256980 33134924 MILAM New Drill 

317 -96.9953280 30.6252920 33134925 MILAM New Drill 

318 -96.9962940 30.6261780 33134926 MILAM New Drill 

319 -96.9987400 30.6313110 33134927 MILAM New Drill 
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320 -96.9985900 30.6307390 33134928 MILAM New Drill 

321 -96.9996200 30.6311640 33134929 MILAM New Drill 

322 -97.0000700 30.6308310 33134930 MILAM New Drill 

323 -96.9995980 30.6304250 33134931 MILAM New Drill 

324 -97.0007790 30.6306280 33134932 MILAM New Drill 

325 -97.0013150 30.6276560 33134933 MILAM New Drill 

326 -97.0536720 30.7099340 33134905 MILAM New Drill 

327 -97.0009720 30.6263630 33134934 MILAM New Drill 

328 -96.6290240 30.1699240 47731023 WASHINGTON New Drill 

329 -96.7175370 30.1916440 47731024 WASHINGTON New Drill 

330 -96.7049630 30.1418700 47731025 WASHINGTON New Drill 

 

Disposal Wells: (Active disposal wells)  

ID X Y Field Name County 

1 -97.4168 30.008379 HILBIG BASTROP 

2 -97.415577 30.009772 HILBIG BASTROP 

3 -97.481731 29.963997 BATEMAN (AUSTIN CHALK) BASTROP 

4 -97.521588 30.096842 CEDAR CREEK BASTROP 

5 -97.415412 30.006106 HILBIG BASTROP 

6 -97.412386 30.006218 HILBIG BASTROP 

7 -97.41039 30.006515 HILBIG BASTROP 

8 -97.054579 30.115196 SERBIN (WILCOX) BASTROP 

9 -97.414317 30.008076 HILBIG BASTROP 
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10 -97.412858 30.004193 HILBIG BASTROP 

11 -97.413834 30.010204 HILBIG BASTROP 

12 -97.508307 29.956803 BATEMAN (AUSTIN CHALK) BASTROP 

13 -97.54502 30.064018 YOAST BASTROP 

14 -97.551318 29.890782 BUCHANAN CALDWELL 

15 -97.621715 29.826448 LULING-BRANYON CALDWELL 

16 -97.612824 29.835582 LULING-BRANYON CALDWELL 

17 -97.594735 29.842823 LULING-BRANYON CALDWELL 

18 -97.702281 29.754133 LULING-BRANYON CALDWELL 

19 -97.725562 29.72572 LULING-BRANYON CALDWELL 

20 -97.718653 29.731012 LULING-BRANYON CALDWELL 

21 -97.709598 29.759275 LULING-BRANYON CALDWELL 

22 -97.700736 29.764639 LULING-BRANYON CALDWELL 

23 -97.728867 29.726969 LULING-BRANYON CALDWELL 

24 -97.690436 29.761808 LULING-BRANYON CALDWELL 

25 -97.723159 29.731366 LULING-BRANYON CALDWELL 

26 -97.577333 29.784047 SALT FLAT CALDWELL 

27 -97.618295 29.738633 SALT FLAT CALDWELL 

28 -97.592868 29.76924 SALT FLAT CALDWELL 

29 -97.635955 29.708762 SALT FLAT CALDWELL 

30 -97.629625 29.720801 SALT FLAT CALDWELL 

31 -97.567891 29.790025 TENNEY CREEK CALDWELL 

32 -97.72112 29.736975 LULING-BRANYON CALDWELL 
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33 -97.6405643 29.6842762 SALT FLAT CALDWELL 

34 -97.6292795 29.6937916 SALT FLAT CALDWELL 

35    LULING-BRANYON CALDWELL 

36 -97.6714419 29.6963743 DUNLAP CALDWELL 

37 -97.7146414 29.7416108 LULING-BRANYON CALDWELL 

38 -97.6405628 29.7496488 DUNLAP CALDWELL 

39 -97.6570022 29.7360311 DUNLAP CALDWELL 

40 -97.6652194 29.6940356 SALT FLAT, WEST CALDWELL 

41 -97.6540589 29.7074551 SALT FLAT CALDWELL 

42 -97.6659842 29.7285283 DUNLAP CALDWELL 

43 -97.5277346 29.9036294 BUCHANAN CALDWELL 

44 -97.6272145 29.7224724 SALT FLAT CALDWELL 

45 -97.6007976 29.8252947 LULING-BRANYON CALDWELL 

46 -97.5537374 29.7995706 TENNEY CREEK CALDWELL 

47 -97.6209143 29.7095628 SALT FLAT CALDWELL 

48 -97.6123635 29.7609587 SALT FLAT CALDWELL 

49 -97.5656131 29.7954833 TENNEY CREEK CALDWELL 

50 -97.6701386 29.7031532 SALT FLAT, WEST CALDWELL 

51 -97.5670053 29.7889057 TENNEY CREEK CALDWELL 

52 -97.7342397 29.7132051 LULING-BRANYON CALDWELL 

53 -97.6448572 29.7830929 LULING (EDWARDS) CALDWELL 

54 -97.6295075 29.6871979 SALT FLAT CALDWELL 

55 -97.725489 29.8963987 LARREMORE CALDWELL 
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56 -97.5639367 29.7980683 SALT FLAT CALDWELL 

57 -97.5639974 29.8738483 LULING-BRANYON CALDWELL 

58 -97.671815 29.7157152 DUNLAP CALDWELL 

59 -97.6289652 29.8087675 LULING-BRANYON CALDWELL 

60 -97.7298942 29.8958356 LARREMORE CALDWELL 

61 -97.5719379 29.9856708 LYTTON SPRINGS CALDWELL 

62 -97.5978533 29.9637683 LYTTON SPRINGS CALDWELL 

63 -97.6196524 29.806525 LULING-BRANYON CALDWELL 

64 -97.7029791 29.7522093 LULING-BRANYON CALDWELL 

65 -97.7084363 29.7506621 LULING-BRANYON CALDWELL 

66 -97.5810868 29.7785177 SALT FLAT CALDWELL 

67 -97.6877956 29.7644576 LULING-BRANYON CALDWELL 

68 -97.5429944 29.8973449 BUCHANAN CALDWELL 

69 -97.6284737 29.7198281 SALT FLAT CALDWELL 

70 -97.5731407 29.7908901 TENNEY CREEK CALDWELL 

71 -97.5597475 29.8793673 BUCHANAN CALDWELL 

72 -97.6984335 29.7620581 LULING-BRANYON CALDWELL 

73 -97.6365956 29.8045915 LULING-BRANYON CALDWELL 

74 -97.636455 29.7070729 SALT FLAT CALDWELL 

75 -97.7255757 29.7248204 LULING-BRANYON CALDWELL 

76 -97.7348038 29.7145348 LULING-BRANYON CALDWELL 

77 -97.686457 29.6990793 DUNLAP CALDWELL 

78 -97.5859249 29.8493026 LULING-BRANYON CALDWELL 
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79 -97.6623624 29.7812903 LULING-BRANYON CALDWELL 

80 -97.6429103 29.6924132 SALT FLAT CALDWELL 

81 -97.6252755 29.8024226 LULING-BRANYON CALDWELL 

82 -97.5099024 29.9203742 DALE-MCBRIDE CALDWELL 

83 -97.6482205 29.775193 LULING-BRANYON CALDWELL 

84 -97.5127045 29.913079 DALE-MCBRIDE CALDWELL 

85 -97.7206689 29.8178341 FENTRESS (1750) CALDWELL 

86 -97.631643 29.7169568 SALT FLAT CALDWELL 

87 -97.5984665 29.7656229 SALT FLAT (EDWARDS) CALDWELL 

88 -97.6747623 29.6997651 DUNLAP CALDWELL 

89 -97.6007093 29.7452469 SALT FLAT (EDWARDS) CALDWELL 

90 -97.7368784 29.6977546 LULING-BRANYON CALDWELL 

91 -97.7350629 29.6993779 LULING-BRANYON CALDWELL 

92 -97.7392531 29.6981575 LULING-BRANYON CALDWELL 

93 -97.7375264 29.6993684 LULING-BRANYON CALDWELL 

94 -97.7360341 29.7006631 LULING-BRANYON CALDWELL 

95 -97.6101224 29.7321541 SALT FLAT (EDWARDS) CALDWELL 

96 -97.6246169 29.7288028 SALT FLAT (EDWARDS) CALDWELL 

97 -97.6357522 29.701244 SALT FLAT (EDWARDS) CALDWELL 

98 -97.5227165 29.915815 DALE-MCBRIDE CALDWELL 

99 -97.6131102 29.8176562 LULING-BRANYON CALDWELL 

100 -97.5241434 29.9123345 DALE-MCBRIDE CALDWELL 

101 -97.630453 29.9669866 DRUMMOND (EDWARDS 1800) CALDWELL 
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102 -97.5861493 29.7675982 SALT FLAT (EDWARDS) CALDWELL 

103 -97.6164497 29.7255254 SALT FLAT (EDWARDS) CALDWELL 

104 -97.5856899 29.7794303 SALT FLAT (EDWARDS) CALDWELL 

105 -97.6305917 29.7072055 SALT FLAT (EDWARDS) CALDWELL 

106 -97.5946667 29.755617 SALT FLAT (EDWARDS) CALDWELL 

107 -97.6404622 29.6950767 SALT FLAT (EDWARDS) CALDWELL 

108 -97.7290784 29.7016732 LULING-BRANYON CALDWELL 

109 -97.7338003 29.8921958 LARREMORE CALDWELL 

110 -97.6019788 29.7440872 SALT FLAT (EDWARDS) CALDWELL 

111 -97.673361 29.697984 SALT FLAT, WEST CALDWELL 

112 -97.63275 29.8060361  CALDWELL 

113 -97.6702098 29.7824104  CALDWELL 

114 -97.6308268 29.8000036  CALDWELL 

115 -97.6188968 29.7383506 SALT FLAT (EDWARDS) CALDWELL 

116 -96.932243 30.164125 GIDDINGS (BUDA) LEE 

117 -96.973592 30.1885 GIDDINGS (AUSTIN CHALK-3) LEE 

118 -96.92205 30.526926 NOACK COW HERD (3460) LEE 

119 -96.817831 30.266165 GIDDINGS (AUSTIN CHALK, GAS) LEE 

120 -96.571254 30.381325 GIDDINGS (AUSTIN CHALK-3) BURLESON 

121 -96.574518 30.415229 CALDWELL (AUSTIN CHALK) BURLESON 

122 -96.539768 30.41475 GIDDINGS (AUSTIN CHALK-3) BURLESON 

123 -96.581449 30.379434 GIDDINGS (WILCOX) BURLESON 

124 -96.560025 30.397846 GIDDINGS (AUSTIN CHALK-3) BURLESON 
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125 -96.554136 30.389965 GIDDINGS (AUSTIN CHALK-3) BURLESON 

126 -96.337468 30.377543 JERRY'S QUARTERS (A C 11900) BURLESON 

127 -96.928294 30.570814 BURMIL (W-2 SAND) BURLESON 

128 -96.618718 30.702712 GIDDINGS (AUSTIN CHALK-3) BURLESON 

129 -97.130122 29.841009 GIDDINGS (AUSTIN CHALK-3) FAYETTE 

130 -96.834414 30.064494 GINI (WILCOX) FAYETTE 

131 -96.826265 30.083836 GINI (WILCOX) FAYETTE 

132 -96.832889 30.068869 GINI (WILCOX) FAYETTE 

133 -96.989527 29.938434 GIDDINGS (AUSTIN CHALK-3) FAYETTE 

134 -96.839163 30.016372 GIDDINGS (AUSTIN CHALK-3) FAYETTE 

135 -96.858554 29.990143 JORDAN CREEK (WILCOX 5700) FAYETTE 

136 -96.807167 30.125853 STEPHANIE (WILCOX) FAYETTE 

137 -96.828649 30.10345 GIDDINGS (AUSTIN CHALK-3) FAYETTE 

138 -96.899739 30.090144 GIDDINGS (NORTH EDWARDS) FAYETTE 

139 -96.837257 30.063064 GINI (WILCOX) FAYETTE 

140 -96.951731 29.924009 GIDDINGS (AUSTIN CHALK-3) FAYETTE 

141 -97.086561 29.701274 GIDDINGS (AUSTIN CHALK-3) FAYETTE 

142 -97.540974 29.171429 DUBOSE (EDWARDS -A-) GONZALES 

143 -97.461593 29.444501 MAG (BUDA) GONZALES 

144 -97.629743 29.263289 FIRST SHOT (AUSTIN CHALK) GONZALES 

145 -97.267723 29.666755 WAELDER, SOUTH (ESCONDIDO) GONZALES 

146 -97.510553 29.31698 PILGRIM (AUSTIN CHALK) GONZALES 

147 -97.35416 29.608153  GONZALES 
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148 -97.267434 29.463838 AUSTIN PIERCE (AUSTIN CHALK) GONZALES 

149 -97.387082 29.300755 FULCHER (EDWARDS A) GONZALES 

150 -97.396383 29.307472 EAGLEVILLE (EAGLE FORD-1) GONZALES 

151 -97.396945 29.432949 PILGRIM (AUSTIN CHALK) GONZALES 

152 -97.433573 29.456691 EAGLEVILLE (EAGLE FORD-1) GONZALES 

153 -97.375486 29.326734 EAGLEVILLE (EAGLE FORD-1) GONZALES 

154 -97.732972 29.340333 NIXON GONZALES 

155 -97.535647 29.224712 EAGLEVILLE (EAGLE FORD-1) GONZALES 

156 -97.379098 29.527845 PEACH CREEK (AUSTIN CHALK) GONZALES 

157 -97.762095 29.297491 NIXON GONZALES 

158 -97.796432 29.55068 DARST CREEK (BUDA) GUADALUPE 

159 -97.719664 29.617114 DARST CREEK (BUDA) GUADALUPE 

160 -97.750047 29.595626 DARST CREEK (BUDA) GUADALUPE 

161 -97.750374 29.595254 DARST CREEK (BUDA) GUADALUPE 

162 -97.749549 29.596024 DARST CREEK (BUDA) GUADALUPE 

163 -97.765788 29.582037 DARST CREEK (EDWARDS) GUADALUPE 

164 -97.735843 29.610796 DARST CREEK (EDWARDS) GUADALUPE 

165 -97.738832 29.608547 DARST CREEK (EDWARDS) GUADALUPE 

166 -97.746714 29.60362 DARST CREEK (EDWARDS) GUADALUPE 

167 -97.738404 29.610372 DARST CREEK (EDWARDS) GUADALUPE 

168 -97.709467 29.681041 DUNLAP GUADALUPE 

169 -97.731143 29.656708 DUNLAP GUADALUPE 

170 -97.720996 29.667543 DUNLAP GUADALUPE 
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171 -97.754274 29.703531 LULING-BRANYON GUADALUPE 

172 -97.757917 29.689004 LULING-BRANYON GUADALUPE 

173 -97.750194 29.698208 LULING-BRANYON GUADALUPE 

174 -97.743147 29.703547 LULING-BRANYON GUADALUPE 

175 -97.760727 29.68908 LULING-BRANYON GUADALUPE 

176 -97.754989 29.704808 LULING-BRANYON GUADALUPE 

177 -97.7569 29.567365 DARST CREEK (EDWARDS) GUADALUPE 

178 -97.746344 29.603596 DARST CREEK (EDWARDS) GUADALUPE 

179 -97.744464 29.603925 DARST CREEK (EDWARDS) GUADALUPE 

180 -97.736784 29.612474 DARST CREEK (EDWARDS) GUADALUPE 

181 -97.73258 29.611078 DARST CREEK (EDWARDS) GUADALUPE 

182 -97.786773 29.558398 DARST CREEK (EDWARDS) GUADALUPE 

183 -97.752263 29.582618 DARST CREEK (BUDA) GUADALUPE 

184 -97.77391 29.56974 DARST CREEK (EDWARDS) GUADALUPE 

185 -97.761441 29.688941 LULING-BRANYON GUADALUPE 

186 -97.69134 29.611094 KENS (SERPENTINE) GUADALUPE 

187 -97.653833 29.665106 SALT FLAT GUADALUPE 

188 -97.770973 29.573311 DARST CREEK (BUDA) GUADALUPE 

189 -98.02625 29.409987 LA VERNIA (AUSTIN CHALK) GUADALUPE 

190 -97.749596 29.703977 LULING-BRANYON GUADALUPE 

191 -97.750098 29.703251 LULING-BRANYON GUADALUPE 

192 -97.739009 29.686618 SPILLER GUADALUPE 

193 -97.740215 29.684996 SPILLER GUADALUPE 
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194 -97.749771 29.706314 LULING-BRANYON GUADALUPE 

195 -97.752457 29.703039 LULING-BRANYON GUADALUPE 

196 -97.748909 29.700394 LULING-BRANYON GUADALUPE 

197 -97.739132 29.688939 SPILLER GUADALUPE 

198 -97.75731 29.692582 LULING-BRANYON GUADALUPE 

199 -97.744836 29.693427 LULING-BRANYON GUADALUPE 

200 -97.742972 29.683032 SPILLER GUADALUPE 

201 -97.745584 29.681463 SPILLER GUADALUPE 

202 -97.747532 29.681144 SPILLER GUADALUPE 

203 -97.759059 29.5863 DARST CREEK (EDWARDS) GUADALUPE 

204 -97.747117 29.697361 LULING-BRANYON GUADALUPE 

205 -97.746972 29.595352 DARST CREEK (EDWARDS) GUADALUPE 

206 -97.859808 29.383688 NIXON GUADALUPE 

207 -97.818577 29.652262 KINGSBURY (BUDA LIME) GUADALUPE 

208 -97.72842 29.659081 DUNLAP GUADALUPE 

209 -97.723746 29.661919 DUNLAP GUADALUPE 

210 -97.75272 29.689495 LULING-BRANYON GUADALUPE 

211 -97.73663 29.665637 SPILLER GUADALUPE 

212 -96.864012 30.617106 MILBUR, N. (WILCOX 2660) MILAM 

213 -96.842527 30.709645 MILANO, SOUTH (AUSTIN CHALK) MILAM 

214 -96.96903 30.605972 BULLOH (NAVARRO) MILAM 

215 -96.862504 30.62283 PECAN GAP (5050) MILAM 

216 -96.895199 30.644159 MIDWAY (2300 OIL) MILAM 
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217 -97.021059 30.720961 MINERVA-ROCKDALE MILAM 

218 -97.02659 30.74966 MINERVA-ROCKDALE MILAM 

219 -97.02556 30.74912 MINERVA-ROCKDALE MILAM 

220 -97.02978 30.75045 MINERVA-ROCKDALE MILAM 

221 -97.02861 30.75094 MINERVA-ROCKDALE MILAM 

222 -97.031727 30.746751 MINERVA-ROCKDALE MILAM 

223 -97.032104 30.745067 MINERVA-ROCKDALE MILAM 

224 -97.032345 30.7405 MINERVA-ROCKDALE MILAM 

225 -97.030242 30.734718 MINERVA-ROCKDALE MILAM 

226 -97.029229 30.749038 MINERVA-ROCKDALE MILAM 

227 -97.015582 30.737807 MINERVA-ROCKDALE MILAM 

228 -97.023993 30.746108 MINERVA-ROCKDALE MILAM 

229 -97.02065 30.74108 MINERVA-ROCKDALE MILAM 

230 -97.02154 30.7419 MINERVA-ROCKDALE MILAM 

231 -97.018353 30.737909 MINERVA-ROCKDALE MILAM 

232 -97.018553 30.736926 MINERVA-ROCKDALE MILAM 

233 -97.01874 30.735716 MINERVA-ROCKDALE MILAM 

234 -97.018902 30.734561 MINERVA-ROCKDALE MILAM 

235 -97.019864 30.747643 MINERVA-ROCKDALE MILAM 

236 -97.019782 30.735472 MINERVA-ROCKDALE MILAM 

237 -97.01897 30.73975 MINERVA-ROCKDALE MILAM 

238 -97.017129 30.745953 MINERVA-ROCKDALE MILAM 

239 -97.014155 30.744979 MINERVA-ROCKDALE MILAM 
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240 -97.017684 30.724145 MINERVA-ROCKDALE MILAM 

241 -97.019844 30.725484 MINERVA-ROCKDALE MILAM 

242 -97.02203 30.72695 MINERVA-ROCKDALE MILAM 

243 -97.02008 30.73678 MINERVA-ROCKDALE MILAM 

244 -97.02223 30.73389 MINERVA-ROCKDALE MILAM 

245 -97.025345 30.730304 MINERVA-ROCKDALE MILAM 

246 -97.020375 30.736039 MINERVA-ROCKDALE MILAM 

247 -97.018338 30.739097 MINERVA-ROCKDALE MILAM 

248 -97.016184 30.724075 MINERVA-ROCKDALE MILAM 

249 -97.017695 30.720431 MINERVA-ROCKDALE MILAM 

250 -97.018948 30.721488 MINERVA-ROCKDALE MILAM 

251 -97.017668 30.719255 MINERVA-ROCKDALE MILAM 

252 -97.020294 30.716857 MINERVA-ROCKDALE MILAM 

253 -97.020951 30.716257 MINERVA-ROCKDALE MILAM 

254 -97.020348 30.719209 MINERVA-ROCKDALE MILAM 

255 -97.022372 30.719762 MINERVA-ROCKDALE MILAM 

256 -97.02478 30.717564 MINERVA-ROCKDALE MILAM 

257 -97.022774 30.717794 MINERVA-ROCKDALE MILAM 

258 -97.01608 30.72037 MINERVA-ROCKDALE MILAM 

259 -97.029055 30.727504 MINERVA-ROCKDALE MILAM 

260 -97.031585 30.733044 MINERVA-ROCKDALE MILAM 

261 -97.031655 30.734264 MINERVA-ROCKDALE MILAM 

262 -97.02676 30.74106 MINERVA-ROCKDALE MILAM 
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263 -97.0277 30.74 MINERVA-ROCKDALE MILAM 

264 -97.02884 30.73957 MINERVA-ROCKDALE MILAM 

265 -97.02868 30.7385 MINERVA-ROCKDALE MILAM 

266 -97.02951 30.73772 MINERVA-ROCKDALE MILAM 

267 -97.02857 30.73695 MINERVA-ROCKDALE MILAM 

268 -97.02734 30.73654 MINERVA-ROCKDALE MILAM 

269 -97.02761 30.73541 MINERVA-ROCKDALE MILAM 

270 -97.02426 30.74426 MINERVA-ROCKDALE MILAM 

271 -97.026256 30.739928 MINERVA-ROCKDALE MILAM 

272 -97.025428 30.741154 MINERVA-ROCKDALE MILAM 

273 -97.024667 30.742009 MINERVA-ROCKDALE MILAM 

274 -97.029543 30.73373 MINERVA-ROCKDALE MILAM 

275 -97.028944 30.734729 MINERVA-ROCKDALE MILAM 

276 -97.02195 30.73557 MINERVA-ROCKDALE MILAM 

277 -97.016758 30.738047 MINERVA-ROCKDALE MILAM 

278 -97.01945 30.75384 MINERVA-ROCKDALE MILAM 

279 -97.014257 30.744053 MINERVA-ROCKDALE MILAM 

280 -97.020048 30.741515 MINERVA-ROCKDALE MILAM 

281 -97.018954 30.741948 MINERVA-ROCKDALE MILAM 

282 -97.028025 30.727304 MINERVA-ROCKDALE MILAM 

283 -97.028155 30.726464 MINERVA-ROCKDALE MILAM 

284 -97.009374 30.723325 MINERVA-ROCKDALE MILAM 

285 -97.009464 30.720665 MINERVA-ROCKDALE MILAM 
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286 -97.007604 30.721195 MINERVA-ROCKDALE MILAM 

287 -97.006514 30.721115 MINERVA-ROCKDALE MILAM 

288 -97.004734 30.721535 MINERVA-ROCKDALE MILAM 

289 -97.006184 30.717515 MINERVA-ROCKDALE MILAM 

290 -97.005214 30.717215 MINERVA-ROCKDALE MILAM 

291 -97.021012 30.764065 MINERVA-ROCKDALE MILAM 

292 -97.021047 30.762415 MINERVA-ROCKDALE MILAM 

293 -97.010924 30.749863 MINERVA-ROCKDALE MILAM 

294 -97.018254 30.753973 MINERVA-ROCKDALE MILAM 

295 -97.019656 30.755356 MINERVA-ROCKDALE MILAM 

296 -97.01471 30.75387 MINERVA-ROCKDALE MILAM 

297 -97.01481 30.75292 MINERVA-ROCKDALE MILAM 

298 -97.01527 30.741862 MINERVA-ROCKDALE MILAM 

299 -96.99224 30.626453 MINERVA-ROCKDALE MILAM 

300 -97.011788 30.741385 MINERVA-ROCKDALE MILAM 

301 -97.012655 30.743123 MINERVA-ROCKDALE MILAM 

302 -97.011981 30.742579 MINERVA-ROCKDALE MILAM 

303 -97.009425 30.746294 MINERVA-ROCKDALE MILAM 

304 -97.010742 30.746062 MINERVA-ROCKDALE MILAM 

305 -97.013188 30.73666 MINERVA-ROCKDALE MILAM 

306 -97.011294 30.741974 MINERVA-ROCKDALE MILAM 

307 -97.02481 30.74865 MINERVA-ROCKDALE MILAM 

308 -97.022889 30.742147 MINERVA-ROCKDALE MILAM 
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309 -97.021614 30.738444 MINERVA-ROCKDALE MILAM 

310 -97.016734 30.721895 MINERVA-ROCKDALE MILAM 

311 -97.018684 30.726344 MINERVA-ROCKDALE MILAM 

312 -97.02112 30.72664 MINERVA-ROCKDALE MILAM 

313 -97.02282 30.72761 MINERVA-ROCKDALE MILAM 

314 -97.02216 30.73107 MINERVA-ROCKDALE MILAM 

315 -97.02094 30.73524 MINERVA-ROCKDALE MILAM 

316 -96.398339 30.310837 CLAY CREEK WASHINGTON 

317 -96.410269 30.300228 CLAY CREEK WASHINGTON 
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